Global Settings

DEFINITION

The Global settings are the characteristics that constitute the tool's planner.

These elements allow to structure an architecture planning, based on need. (cf. Settings)

These issues must be checked during the initial setup before the start of production of the tool.

A simple need will ask a prompt setup treatment of the subject instead of a complex setup which will require more time.

GENERAL PARAMETERS CONTENTS

Entities that can be handled in the general parameters are

Structural entities

- Dimensions
- Headings
- Forms
- Calendars
  - Daily calendars
  - Daily patterns
  - Hourly calendars
  - Hourly patterns
- Valuation items
- Type of period
- Creation rules
- Events hierarchies
- Times periods

Other entities

- Named filter
  - Events filter
  - Resources filter
Constraints
- Target constraints
- Coherency constraints
- Time gap constraints

Views
- Favorite displays
- Imports and Exports contexts
- Workflows
- Workloads
- Events reports

USE

There are two entry points for manipulating VISUAL PLANNING General Settings:

General Settings panel

This window opens with the menu **Settings > Windows Block > General Settings**

This panel opens:
This panel list all parameterized entities in VISUAL PLANNING.

The absence of symbol indicates that such an entity is not created.

The place of the panel in the screen is described in the plug Views arrangement.

**The menu bar**

General settings are also configurable through the Settings menu > Configuration block
cf. Menu Bar

Setting
**Dimension**

**DEFINITION**

A **Dimension** is an entity representing a group of **resources** that have the same type.

In a business perspective, dimensions can be:

- human resources (managers, employees, subcontractors),
- informational resources (information and information technology, etc.),
- material resources (equipments, tools, construction, rooms, etc.),
- financial resources (budget, etc.).

With VISUAL PLANNING, dimensions are also:

- tasks/occupancies
- absences
- status

Any entity that can be planned is a potential dimension and therefore a **resource**.

**SETTINGS**

**Create a dimension**

Go to the **Global Settings** panel, **right-click on Dimension > Create a Dimension**.

The lower panel is then activated:
This is to specify the characteristics of the dimension. Click on the **OK** button to validate.

Thereafter, it will be necessary to define the **headings** of this dimension.

Settings the parameters is also reachable via this another menu. (cf. **Global Settings**).

The different characteristics of a dimension are:

**Name**

This is the name of the dimension. It allows to define the type of the group of resources that will be into the dimension.

**Description**

This is an optional description of the dimension.
History

This characteristic represents the date, the hour of the last modification on the dimension or on its headings. The login of the user is also stored in it.

This property is automatically updated.

Enable forum

This box, when checked, enables the feature forum on all resources of the dimension.

cf. Forum

Load all resources

This check box allows to choose whether the resources of the dimension have to be set in memory when VISUAL PLANNING is launched or if the resources are loaded according to the selected favourite display.

Automatic event creation

This check box allows to create automatically an event immediately after a resource creation. This event will be planned by default the current date.

Events hierarchy

When “Automatic event creation” is checked, this field allows to choose the event hierarchy of the event.

Activated for events

This check box give the possibility to list all the modifications on the resource events of that dimension. A double-click on the history area allows to display the history of modification.

Activated
This check box give the possibility to list all the modifications on the resource of that dimension. A double-click on the history area allows to display the history of modification.

**Color**

This is the default color of all the future resources of the dimension. This color can be modified for each resource.

cf. color pallet

**Daily calendar**

This is the default daily calendar of all the future resources of the dimension. This daily calendar can be modified for each resource.

cf. daily calendar

**Events creation rule**

This is the default events creation rule of all the future resources of the dimension. This events creation rule can be modified for each resource.

It is possible to define ne creation rule for a dimension, but in this case, the event creation is forbidden.

cf. creation rule

**Hourly calendar**

This is the default hourly calendar of all the future resources of the dimension. This hourly calendar can be modified for each resource.

cf. hourly calendar

**Icon**
This is the default icon of all the future resources of the dimension. This icon can be modified for each resource.

cf. icon

**Single headings**

This is the list of the headings which will define the uniqueness of the resource of the dimension.

**Required headings**

This is the list of the required headings of the dimension.

**Identification headings**

This is the list of the headings that identify the dimension. These headings are represented into a wording.

cf. Identification headings

**Separator**

This is the character which distinguish the identification headings beside.

**Create a heading for the dimension**

These are the constituent headings of the dimension and its resources.

The different types of headings for a dimension are:

- Text,
- Multi-line text,
- Boolean,
- Counter,
- Numerical,
- Single choice list,
- Multiple choice list,
- Hour Date,
- Attachment,
- Barcode,
Modify a dimension

The modification of a dimension involves an important change in the planner's architecture. 
It is a powerful act of setting which should not be made without consideration. 
(c.f. precautions to take when modifying the settings)

To modify a dimension, click on this one in the Global settings panel.

To modify a heading of this dimension, click on this one in the Global settings panel.

In both case, the lower panel is then activated to allows the modification of the features (c.f. Create a dimension).

Delete a dimension

The deletion of a dimension involves an important change in the planner's architecture. 
It is a powerful act of setting which should not be made without consideration. 
(c.f. precautions to take when modifying the settings)

Warning: Deleting a dimension is definitive and lead to the deletion of all the resources of this dimension and all the events of these resources.

To delete a dimension, go on the Global settings panel, Right-click > Delete.

The following message appears :
Then click on:

- **Yes** to confirm the deletion,
- or **No** to cancel.

**Dimension, setting, structure, resource**
Heading

DEFINITION

A **Heading** brings informations on **resources** or **events**.

Headings can be seen as characteristics of **dimensions** and **forms**.

There are many different **headings' types** based on the information to enter.

SETTINGS

Create a heading

To be able to create any type of heading it's mandatory to be alone the only user connected on the planner.

To create a Heading, go to **Global Settings** panel:

- **Right click on the name of a dimension > Create heading**
- **or Right click on the name of a form > Create heading**
Headings' characteristics depends on the chosen **headings' types**.

For each planner, the maximum number of headings that can be created is 1000.

**Duplicate a Heading**

It is also possible to **Duplicate** an existing heading.

To do so, **Right click on the Heading to duplicate > Duplicate**
The new heading is created with the name of the older suffixed by \textit{- copy}.

\section*{Modify a Heading}

The modification of a Heading involves an important change in the planner's architecture.

\textbf{It is a powerful act of setting which should not be made without consideration.}
(cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting the heading in \textbf{Global settings} panel.

The lower part is then activated:

\begin{center}
\includegraphics[width=0.5\textwidth]{heading.png}
\end{center}

Then it is necessary to modify the characteristics (cf. \textit{Create a heading}), then Validate by clicking on the \textbf{OK} button.

If the modification should not be taken into account, you must click on the \textbf{Restore} button.

\section*{Convert a heading's type}

It is impossible to convert heading's type in the setup window of the heading.

To convert a heading from one type to another, \textbf{Right click on the heading > Convert}.

The only changes allowed are:

\begin{center}
\begin{tabular}{|c|c|}
\hline
\textbf{From} & \textbf{To} \\
\hline
\end{tabular}
\end{center}
This conversion will take the existing values in the database.

**Delete a heading**

The deletion of a Heading involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*

(cf. precautions to take when modifying the settings)

The deletion of a heading is made in the **Globals settings** panel.

To do so, **Right click on the heading > Delete**.

A confirmation message appears:

- Click on the **Yes** button to confirm the deletion,
- or on the **No** button to Cancel the deletion.
To delete two headings or more, just press \texttt{Ctrl} or \texttt{Shift} during the selection of headings.
USE

Visual information

That is the most apparent role: the headings are displayed on the screen or on the event's duration bar.

- Schedule view
- Resources view
- Information on event's duration bar

Research criteria and filters

Headings are used to define criteria for different types of filters. So if you want to filter on a certain feature, you must create a heading to include that characteristic.

cf. Filter
cf. AutoFilter

Sort criteria

When a Schedule view and/or Resources view is activated, resources of a dimension can be sorted by heading's features (in case of a tie, this will be according to the values contained in the next two headings).

This sort principle is also present in the Events view.

cf. Sort

Use in valuation item

Numeric headings may be used to define automatics valuations for events.

cf. Valuation item

Use as control thresholds
Some headings may be used to establish control thresholds for Control Column Heading and Operation.

These are the headings:

- Numerical,
- Control Column,
- et Operation

cf. Thresholds

**Identification heading**

For each dimension, it is necessary to define one or several identification headings in order to identify resources on the whole schedule.

cf. Identification Heading

**Single identification key**

This option prevents the repetition of the same value creating, duplicating and importing lines.

Two cases are possible:

**Single identification key for one heading**

The heading's value can be found only once in the whole resources of the dimension.

**Single identification key for several headings**

Combining values from this set of headings can be found only once in the whole resources of the dimension.

**Required heading**

This option forces the user to enter a heading's value defined as mandatory.

Heading
Form

DEFINITION

A form is used to add information in the events in a structured way.

It is therefore increased by an event and appears as an additional tab in the event to which it is attached.

An event can have only one form.

This form has one or more headings.

The forms are then used in the same way than other properties of the event: they are viewed, printed and may serve as data for Event Reports and Event Filters ...

Thus a Form allows no to create dimensions for some characteristics of an event.

SETTINGS

Setting a form occurs in three steps:

1. Create the form
2. Create the headings of the form
3. Assign a form to a rule creation

Create a form

In the Global Settings panel, perform a Right click on Form> Create Form

The lower part opens:
This is to specify the characteristics of the form, then confirm by clicking **OK**

Thereafter, it will be necessary to define the headings of this form.

This setting is also accessible by another entry point (see **Global Settings**).

The following characteristics are to be completed:

**Name**

This is the name of the form.

**Description**

This is an optional description to describe the usefulness of this form.

**History**

It is the date, time of last modification of the form or its headings, and the login of the user who made the last change.

This property is updated automatically.

**Required headings**

The required fields are chosen among the heading list of the form. It is therefore necessary to define
them back after the creation of these headings.

Create a heading for the form

The creation of a heading for the form occurs in the same way as a heading for a dimension.

You must go to the panel **General Settings**> **Right Click on the name of the form**> **Create a Heading**

The lower part opens:
You must fill in the characteristics and then click on **OK**.

**Types of headings** possible for a **form** are:

- Text,
- Multiple-line text,
- Boolean,
- Counter,
- Numerical,
- Drop-down list,
- Multiple-choice list,
- Date time,
- Attachement,
- Barcode,
- Signature,
- Operation,
- Distance.

cf. Heading

It is not possible to assign a single identification key heading. The same information in several forms to the events attached could be filled.

**Assign a form to a creation rule**

After creating the form and its headings, you must assign it to a **creation rule**.

To assign a form to a creation rule of events, you must change the settings of it and choose the form in the list.
Modify a form

The modification of a form involves an important change in the planner's architecture. It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

Change general characteristics of a form

Possible changes are:

- **Name** modification
- **Description** modification
- **Required headings** modification

Modify headings of a form

cf. **creation rule**
cf. **Create a form**
Possible changes are:

- adding a heading
- duplicating a heading
- modifying a heading
- deleting a heading

cf. Set-up a heading

**Delete a form**

Deleting a form implies possible change in the planer architecture. It is a strong act of setting which should not be made without consideration.

(c.f. precautions to take when modifying the configuration)

To delete a form, open the General Settings panel, and make a Right click on Form > Click on the form > delete.

The following message appears:

Finally, you must click **OK** to confirm your deletion.
Use

Enter values in the form of an event

The display of the form in the Properties window of the event results by a new tab.

To enter the different values of the form, you must right click on the event> Edit> Form

It is then possible to enter the value of each heading.
To confirm, simply click on the **OK** button.

**Assign a form to an event**

Form can be automatically attached to event if its creation rule was set like that. (cf. above)

It is also possible to assign a form to an event or directly change the attached form.

To do this, simply make a **Right click on the event > Edit > Assigned Form** , then choose the form.

![Edit an event dialog](image)

**Visualize**

Datas in a form may be displayed:

- on events' duration bars.
- in events' tooltips.
- among events view columns.

**Use by other functions**

Form's headings can be used:

- as criteria of Events filters,
- as criteria in Dimensions filters,
- in the type heading Event value,
- by Constraints,
- to edit control columns,
- to calculate the load and/or the target of Workload,
- for Events reports.

Event, form
Heading types

There are several types of headings.

<table>
<thead>
<tr>
<th>Type</th>
<th>Dimension</th>
<th>Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single line Text</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Multi-line Text</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Boolean</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Counter</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Numerical</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Single choice List</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Multiple choice List</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Hour date</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Attachment</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Barcode</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Resource</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Control column heading</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Operation</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Event value</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Geolocation</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Distance</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Signature</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Password</td>
<td>✔️</td>
<td></td>
</tr>
</tbody>
</table>

LIST OF THE TYPES

Single line Text

cf. Single line Text heading

Multi-line Text

cf. Multi-line Text heading

Boolean

cf. Boolean heading
Counter

cf. Counter heading

Numerical

cf. Numerical heading

Single choice List

cf. Single choice list heading

Multiple choice list

cf. Multiple choice list heading

Date Hour

cf. Date hour heading

Computed Date

cf. Computed date heading

Attachment

cf. Attachment heading

Barcode
cf. Barcode heading

Resource

cf. Resource heading

Control Column

cf. Control column heading

Operation

cf. Operation heading

Event value

cf. Event value heading

Geolocation

cf. Geolocation

Distance

cf. Distance

Signature

cf. Signature

Password
cf. Password

Architecture, heading
Text Heading

DEFINITION

This is a type of heading of a dimension or a form.

The Text type allows to write in a field all the text that is expected.

It can take a Default value.

SETTING

Create a heading

To create a Heading, you must go to Global Settings panel:

- Right click on the chosen dimension's name > Create heading
- or Right click on the chosen form's name > Create heading
- or Right click on the chosen name's heading > Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

This setting is also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Text** heading are the following:
Name

This is the heading's name.

Description

This is the heading's optional description.

Heading type

The Text type is defined. This can not be modified.

Index

If this box is checked, the heading is indexed in the database.

Warning

Index the headings is really useful in some cases.

We strongly recommend to contact the Support of STILOG I.S.T. whether manipulations of this type are needed.

- Email: support[at]stilog[.]com

Default Value

A default value can be used for the creation of a new resource or event.

It is possible to set this value with the global variables of the user:

- $USERNAME
- $GROUPNAME
- $USEREMAIL
- $USERFULLNAME
Prohibit default value

If this box is checked, the user must fill the heading value but he can't use the default value.

Number of characters

The maximum number of characters for a Text heading is 255.

The modification of this setting can not be done if several users are connected.

Format

A format permits to check if the entered value is correct.

The possible formats are the following:

- Zip code
- 10-digit phone
- E-mail
- Start with a capital letter
- All in capital letter

These formats follow the standard REGEX.

It is possible to create other formats by changing the REGEX formula directly in the text box.

To know more about REGEX format, refer to one of the many online documentation.

For example:

- [en:Regular_expression](http://www.regexlib.com)
- [http://www.regexlib.com](http://www.regexlib.com)

Modify a heading
The modification of a heading involves an important change in the planner's architecture. It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting Global settings in the heading's panel.

The lower part is activated. Then, modify the characteristics (cf. Create a heading) and Validate by clicking on the OK button. If the modification should not be taken into account, click on the Restore button.

cf. Modify a heading

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture. It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

cf. Use of heading

Display

These headings are displayed like all the others: cf. visual information

Check the format

When creating/modifying a resource/event, the Text heading are checked. Only values which respect the format can be validated.

Completion

It is possible to visualize the list of values for a Text heading. This list depends on the user's permissions. To see it, click on Ctrl + Space in the edition window of the heading.

Use by other functions

- Sort
- Identification heading
- Events reports
- Export Resources
- Export Events
- Filters

Heading, text
Identification headings

DEFINITION

Identification headings are defined for all resources of a dimension.

They represent each resource of a dimension in the different windows of VISUAL PLANNING.

This display is represented as a concatenation of one or more headings separated by one or more defined characters.

Example:

If the headings called NAME et First name are the two identification headings of the dimension Persons and if the separator is " - ",

Each resource will be represented as following : NAME - First name

- SMITH - John
- JACKSON - Charles
- ...

SETTINGS

The identification headings are defined in the settings of each dimension.

cf. Create a dimension

USE

Identification headings are used in several cases:

Events properties

In the edition window of an event, resources are visible in the Resources block.
Each resource is represented by:

- an icon
- a color
- a text corresponding to the identification headings.

cf. Events properties

Resource headings

Table mode

In a Schedule view or in Resources view (table mode), all resource headings are identified by the
identification headings of their “dependent” resources.

In a resource heading, all the identification headings are shown. These identification headings are separated by a string: the separator.

cf. Resource Heading

Choose a dependent resource

In the edition window of a resource, “dependent” resources are easily shown.

When changing the “dependent” resource, a window appears on a table which contains the identification headings in the different columns.

cf. Assignment

Assign a resource to an event

Assigning a resource is possible by a right-click on the event > Assign
A table which contains columns that are identification headings appears.

cf. Assignment

Imports et Exports

Import resources

When importing resources, if a resource heading must be imported, it is necessary to import the identification headings with the separator defined in the definition of the dimension.

cf. Import Resources

Import events

When importing events, if a resource must be imported, it is necessary to import the identification headings with the separator defined in the definition of the dimension.

cf. Import Events

Export resources

When exporting resources, if a resource heading is exported, the identification headings with the separator are exported.
cf. Export Resources

**Export events**

When exporting events, if a resource is exported, the identification headings with the separator are exported.

cf. Export Events

**Example:**

If the headings called NAME et First name are the two identification headings of the dimension Persons and if the separator is ” - “:

Each resource will be represented as following : NAME - First name

- Each imported resource heading must have the following syntax: NAME - First name (SMITH - John)
- Each exported resource heading will have the following syntax: NAME - First name (SMITH - John)

**Heading, identification**

From:
https://www.visual-planning.com/doc/ - VISUAL PLANNING 5.3 DOCUMENTATION

Permanent link:
https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_d_identification

Last update: 2013/10/18 17:27
Resource Heading

DEFINITION

It is a dimension's heading type.

This type of heading allows to define a “dependent” resource of the same dimension or another..

For this it is necessary to define the dimension of the resource and eventually default value.

This heading type can be used by autofiltering.

SETTINGS

To create a Heading, go to Global Settings panel:

- Right click on the chosen dimension's name > Create heading
- or Right click on the chosen form's name > Create heading
- or Right click on the chosen heading's name > Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

This setting is also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Resource** are the following:

### Name

This is the heading's name.

### Description

This is the heading's optional description.

### Heading type

The **Resource** type is defined. It can not be modified.
Index

If this box is checked, the heading is indexed in the database.

Warning

Index the headings is really useful in some cases.

We strongly recommend to contact the Support of STILOG I.S.T. whether manipulations of this type are needed.

- Email : support[at]stilog[.]com

Default Value

A default value may be used to create a new resource (resource heading) or event (form heading).

Prohibit default value

If this box is checked, the user must fill the heading value but he can't use the default value.

Autofiltering

If it is checked, this box allows to define this heading as being subject to autofiltering.

cf. Autofilter

Resource filter

It is possible to define the resources that could be referenced by the ressource's heading. To do this, it is necessary to set the filter of resources.

Associate to events
This box if it is checked allows to affects a “dependent” resource for the events which are or will be created.

**Dimension**

It is necessary to define the “dependent” resource **dimension**.

**Modify a heading**

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The following lower part is then activated :

Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

**Delete a heading**

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. **Delete a heading**

**USE**
Assign to a resource

It is possible to associate a resource with another resource called “dependent”.

Right click on a resource > Modify > Chose a “dependent” resource by clicking on: if the “dependent” dimension contain more than 1000 resources or otherwise by selecting one value of the list.

cf. Assignment

Associate to events

If the box Associate to event is checked, the “dependent” resource is assigned to all events of the resource.

Any events created on this resource is also assigned to the “dependent” resource.

An event can only have one resource of the same dimension.

So, it is highly recommended to define distinct dimensions for each resource headings of a dimension.

In addition, verify that a hierarchy allows this association.

Modify a dependent resource

If the Associate to event box is checked, when the user modifies a “dependent” resource of a resource, the following message appears:

Three options are available:

- Yes to All : All the events will be modified with the new dependent resource,
- Yes from a beginning date : All the events will be modified if they begin after the chosen date,
- No : The modification does not concern the past events.
Heading, resource
Events hierarchy

DEFINITION

An Events hierarchy is a possible configuration of resources which allows to constitute an Event.

There are two types of hierarchies that can be combined together:

- **Horizontal hierarchy**: It is a combination of several dimensions on the same hierarchical level.
- **Vertical hierarchy**: In this case, the dimensions are organized into a hierarchy between them. So, there are father events and son events such as:
  - A son event gets all the resources of the father event.
  - The dates of the son events are inclusive of those of the father event.

SETTINGS

Absence of hierarchy

There is a default hierarchy, but it is not visible in the Global Settings.

This absence of additional hierarchy is seen by the absence of the symbol: 

![Global Settings](https://www.visual-planning.com/doc/)

This masked hierarchy is the simpliest hierarchy that can exist. It is an horizontal hierarchy and contains all the dimensions on the same hierarchical level. There is no required dimension.

That means that some events cannot have this configuration.

Create a hierarchy

To create a hierarchy, **Right-click on Events hierarchy > Create Events hierarchy**.
The lower part of the global settings is then opened:

![Global settings](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/hierarchie_d_evenements)

Give to the new hierarchy:

- a **Name**, 
- an optional **Description**
- define if the hierarchy is active or not,
- and define the **Configuration** of the hierarchy by **clicking** on the **button.**

The following window appears:
In this window, each existing dimension is represented in the form of a column.

Thus, for each dimension, define via the checkboxes:

- its existence or not in the hierarchy,
- his Required characteristic or not. It can be set in the last row in the bottom of the window,
- the resources filter of the dimensions which are included in the hierarchy,
- its hierarchical level: the Level 1 corresponds to the mother-dimension, the Level to corresponds to the daughter-dimension, etc.

If there are many levels, the comportement of the sons for the dates may be:

- **Similar**: the sons have the same dates as the father,
- **Continuous**: the sum of the duration of the sons events is equal to the duration of the father event,
- **Free constraint**: the sons events can be freely put in the period of the father event, but not outside,
- **Free unconstraint**: the sons events can be freely shifted in or out the period of the father event, then the father event period is rebuilt.

**Incompatible Hierarchies**

Upon validation of the hierarchy, the following message may appear:

This message means that the new hierarchy is incompatible with at least one other existing
hierarchies.

An incompatibility between hierarchies is determined by the association (Dimension-filter name) at the first level of the hierarchy. If another hierarchy has the same definition at the first level, then it is incompatible.

**Example:**

The hierarchy 1 and the hierarchy 2 are defined like:

<table>
<thead>
<tr>
<th>Hierarchy 1</th>
<th>Dimension 1</th>
<th>Dimension 2</th>
<th>Dimension 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Level 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Required</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>All</td>
<td>All</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hierarchy 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension 1</td>
</tr>
<tr>
<td>Level 1</td>
</tr>
<tr>
<td>Level 2</td>
</tr>
<tr>
<td>Required</td>
</tr>
<tr>
<td>Filter</td>
</tr>
</tbody>
</table>

These two hierarchies are incompatible because in both cases it is possible to create the same type of environment, in this instance an event with a resource from only one dimension.

To make compatible these two hierarchies, it is necessary to define like:

<table>
<thead>
<tr>
<th>Hierarchy 1</th>
<th>Dimension 1</th>
<th>Dimension 2</th>
<th>Dimension 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Level 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Required</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>All</td>
<td>All</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hierarchy 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension 1</td>
</tr>
<tr>
<td>Level 1</td>
</tr>
<tr>
<td>Level 2</td>
</tr>
<tr>
<td>Required</td>
</tr>
<tr>
<td>Filter</td>
</tr>
</tbody>
</table>

**Modify a hierarchy**
The modification of a hierarchy involves an important change in the planner's architecture. It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

To modify a hierarchy, go to Global settings > Events hierarchy > Click on the right hierarchy and modify the Configuration of this hierarchy. (cf. Create a hierarchy)

The modifications of a hierarchy will be only impacted on the future created or modified events.

The existing events, if they are not modified, have no change.

Delete a hierarchy

The deletion of a hierarchy involves an important change in the planner's architecture. It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

To delete a hierarchy, Right-Click on an Events hierarchy > Delete.

The deletion of a hierarchy does not delete the events of this type. The existing events have no change.
USE

Using hierarchies is not visible on the planner.

This is a verification that is made during every creation, repetition, modification, import of an event.

A new event must be compatible with at least one existing hierarchy. If not, the event is not created.

Any dimension may be required. In this case, it is necessary to choose into a list the missing resource. Then the existing filters and the availability filtering can be used into the window that appears.

Event, hierarchy, configuration
Boolean heading

DEFINITION

This is a heading's type for a dimension or a form.

The Boolean is binary and is represented by a checkbox.

He can have a Default value.

These headings can be used in Autofiltering, except for the forms.(cf. Autofiltering)

SETTINGS

Create a heading

To create a Heading, you must go to Global Settings panel:

- Right click on the chosen dimension's name> Create heading
- or Right click on the chosen form's name> Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.
These settings are also accessible by another entry point (c.f Global Settings).

Characteristics of a Boolean heading are the following:

**Name**

This is the heading's name.

**Description**

This is the heading's optional description.

**Type**

The type is **Boolean**. It can not be modified.

**Default value**

A heading's default value is necessary. It will be used at the creation of a new resource (heading resource case) or event (heading form case).

**Prohibit default value**

If this box is checked, the user must fill the heading's value but he can't use the default value.

**Autofiltering**

This box allows, if it is checked, to submit the heading to autofiltering. This option is not available for the forms.

cf. **Autofiltering**

**Modify a heading**
The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The lower part is then activated.

Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

---

**Delete a heading**

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

(cf. Delete a heading)
USE

cf. Heading use

Display

These heading's are displayed like all the others: cf. Visual information

Enter a value

In resources and events properties windows, you can modify the value:

Two cases:

- checked :

- unchecked :

Research criteria and filters

These headings can be sorted like the others: cf. Research criteria and filters

Moreover, they allow to use Automatic filters.

Use by other functions

- Sort
- Identification heading
- Events Report
- Export Resources
- Export Events

Heading, boolean
Counter Heading type

DEFINITION

This is a type of heading for a dimension or a form.

The Counter Heading is incremental and can not be entered by a user.

It is made of:

- A start: starting value for the increment
- A Format which is an incremental value, a date and/or additional characters. There are three predefined formats: Order year, Timestamp and Simple.

SETTINGS

Create a heading

To create a Heading, go to Global Settings panel:

- Right click on the chosen dimension's name> Create heading
- or Right click on the chosen form's name> Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

These settings are also accessible by another entry point (c.f **Global Settings**).

Characteristics of an Attachment heading are the following:
Name

This is the heading's name.

Description

This is the heading's optional description.

Type

The type is **Counter**. It can not be modified.

Start

It is the starting value.

Example:

If the **Format** is `{n,0000}` and the value “**Start**” is equal to 1, then the heading value for the first resource will be: **0001**.

For the following resources, it will be **0002, 0003**, etc.

Format

The default format is empty. It is necessary to enter a value into the heading.

There are three predefined formats:

- **Order year C{d,yyyy}{n,0000}**, this format is the concatenation of:
  - the letter “C”,
  - the current year,
  - and an incremental number of 4 figures.
- **Horodatage {d,yyyyMMddHHmmss}**, it represents the current Date/Hour.
- **Simple {n,0000}**, it represents an incremental number of 4 figures.

You can edit and adapt existing formats to your need. It is necessary to respect the standard of the format defined by the three examples.
Sample format which can be created: ID - \{n,00000\} - \{d,HHmm\}

The value of this heading for future resources will be:

ID - a number with five digits - the hour/minute creation of the resource:

- ID - 000001 - 0850
- ID - 000002 - 0912
- ...

Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting Global settings in the heading's panel.

The following lower part is then activated:

Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the OK button.

If the modification should not be taken into account, you must click on the Restore button.

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

cf. Heading use

Display

These headings are displayed like all the others: cf. visual information

Create a resource or an event

A heading counter does not require particular use.

The ressource (dimension's heading) or event creation (form's heading) automatically gives a value to the heading.

The user can only view the heading's value in the Properties window of the resource or event.

![Calculations]

| Counter Heading | 0001 |

Use by other features

- Sort
- Identification heading
- Event Reports
- Export Resources
- Export Events

From: https://www.visual-planning.com/doc/  -  VISUAL PLANNING 5.3 DOCUMENTATION

Permanent link: https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_de_type_compteur

Last update: 2013/10/17 09:04
Numerical Heading

DEFINITION

This is a type of heading for dimension or form.

This type of heading requires:

- a **default value**
- a **minimum value**
- a **maximum value**
- a **display format**:
  - Integer : 0
  - Decimal : 0.00
  - Percentage : 0%
  - Decimal percentage : 0.00%

SETTINGS

Create a heading

To create a Heading, go to **Global Settings** panel:

- **Right click on the chosen dimension's name** > Create heading
- **or Right click on the chosen form's name** > Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

This setting is also accessible by another entry point (cf. **Global Settings**).

Characteristics of an Attachment heading are the following:
Name

This is the heading's name.

Description

This is the heading's optional description.

Heading type

The **Numeric** type is defined. It can not be modified.

Index

If this box is checked, the heading is indexed in the database.

Warning

Index the headings is really useful in some cases.

We strongly recommend to contact the Support of STILOG I.S.T. whether manipulations of this type are needed.

- Email : support[at]stilog[.]com

Default value

A default value may be used to create a new resource (resource heading) or event (form heading).

Prohibit default value

If this box is checked, the user must fill the heading value but he can't use the default value.
Minimum Value, Maximum Value

The parameters of minimum and maximum value are used to set bounds on possible values. These parameters can be equal to \(-\infty\) and / or \(\infty\), if these limits are not defined.

Display format

- Integer: select 0 value.
- Decimal: Select 0,00 value.
- Integer percentage: select 0\% value.
- Decimal percentage: select 0,00\% value.
- Duration: select hh:mm value.

It is possible to define your own format.

For example:

- 0 $  
- 0 Days  
- 0 Kilometers

Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting Global settings in the heading's panel.

The following lower part is then activated:

Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the OK button.

If the modification should not be taken into account, you must click on the Restore button.
Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

cf. Use of Headings

Display

These headings are displayed like all the others: cf. heading's visualization

Enter a value

In the resources properties window Right click on a resource > Modify.

Or in events properties window : Right click on an event > Modify > Form.

A numeric heading appears like that:

![Numerical heading: 0.00]

Then, just enter a value.

Use as a threshold

Numerics headings can be used as Thresholds in control columns and Workloads.

Use as calculation heading

Calculation heading can use numerics heading to execute their calculation.

Display totals in a resources view

In a resources view, in table mode, it is possible to display the totals of numerical headings.

For this, you have to check the box “Display totals” in Edit display settings window of the resources view.
cf. Resources view

Use by other features

- Sort
- Identification heading
- Events Report
- Export Resources
- Export Events
- Filters

heading, numerical
Operation Heading

DEFINITION

It is a heading of a dimension.

A heading **Operation** allows a numerical calculation between two or several headings of the same dimension, for each one of the resources of a dimension.

This heading can be **persistent** or not.

It is possible to set **thresholds** (objectives) like the other calculated headings.

It is possible to define two types of operation headings:

- **Duration**,
- **Formula**.

OPERATION HEADING - DURATION

cf. Operation heading - Duration

OPERATION HEADING - FORMULA

cf. Operation heading - Formula

Heading, operation, numerical, duration, formula
Heading persistence

DEFINITION

Some heading types can be defined as persistent.
This involves storing the calculation results in database.

This persistence attribute is applicable to the following headings types:

- Control column,
- Operation,
- Events value.

USE

When a heading is defined as persistent, it runs:

- the use of the Filter,
- the use of the Search function,
- the use of certain characteristics of the Creation rule, according to the heading,
- the use of the Export Resources and of the events,
- the use of the sort function,
- the use of the thresholds function.
- the background colour function using the heading as reference.

Persistence, heading

From: https://www.visual-planning.com/doc/ - VISUAL PLANNING 5.3 DOCUMENTATION
Permanent link: https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_persistante
Last update: 2013/10/17 10:18
Control Column Heading

DEFINITION

It is a dimension heading type.

A Control column heading type allows to make some calculations:

- for each resource of a given dimension,
- for all the events that meet filter,
- during a defined period.

This calculation may concerns:

- either the number of events,
- or the duration,
- or the load,
- or some numeric values of a form,
- or some valuation items.

A control column can be persistent or not.

SETTINGS

Create a control column heading

In the Global Settings panel, Right-Click on a dimension > Create a heading
Then, set the features of the new heading in the lower part of the **Global Settings** panel:
Finally, Click on the OK button to save the new heading.

This setting is also available by another entry point. (cf. Global settings).

The different features of a Control column heading are:

**Name**

The name of the Control column heading.

**Description**

This is an optional Description that will appears into a tooltip.

**Type**

The type is Control column.
Calculation type

The Calculation type describes the type of numerical information to take into account, for each resource, on all the events that answer to the filter for the defined period (c.f. Period).

The Calculation type is chosen between:

Number of events

The calculation will be done by counting 1 for each event.

Events Duration (h)

It is a conversion \(^1\) into hours of all the events concerned by the calculation.

Events duration (d)

It is a conversion \(^2\) into days of all the events concerned by the calculation.

Achieved duration (h)

When there are non achieved events, it is a conversion \(^3\) into hours of the achieved duration of all the events on which a calculation is done, according to the Achievement rate.

Achieved duration (j)

When there are non achieved events, it is a conversion \(^4\) into days of the achieved duration of all the events on which a calculation is done, according to the Achievement rate.

Occupation duration (h)

This is the duration in hours covered by the set of events, even if they overlap. This duration is discontinuous.
If two events overlap completely, so their duration is counted only once.

**Occupation duration (d)**

This is the duration in days covered by the set of events, even if they overlap. This duration is discontinuous.

If two events overlap completely, so their duration is counted only once.

**Free period duration (h)**

It is a conversion into hours of all the free periods of the filtered period of the calculation. c.f. Free period

**Free period duration (d)**

It is a conversion into days of all the free periods of the filtered period of the calculation. c.f. Free period

**Load in hours (h)**

It is a sum, in hours, of the loads of the events of the resource which meet the event filter and is included in the period. c.f. Load

It is necessary to choose a type of calculation of this charge. Thus, you must choose among the following values:

- sum
- Average per event
- Average per day
- Average per hour

**Load in days (d)**

It is a sum, in days, of the loads of the events of the resource which meet the event filter and is included in the period. c.f. Load

It is necessary to choose a type of calculation of this charge. Thus, you must choose among the following values:
• sum
• Average per event
• Average per day
• Average per hour

**Free load (h)**

This is the difference between the calendar time in hours and the event's load involved.

**Free load (d)**

This is the difference between the calendar time in days and the event's load involved.

**Valuations**

It is a sum of the valuation items that are selected. When the Valuation items calculation is selected, it is necessary to precise:

• the valuation items to take in account,
• the calculation unity,
• and the calculation type that may be the:
  ◦ sum
  ◦ average per event
  ◦ average per day
  ◦ average per hour

**Forms value**

It is a sum of the numerical headings of the forms that are selected.

To do so, select into **forms headings** the button ![button](image)

By **clicking on the button on the right**, the following window appears:
Select the forms headings to totalise by checking the appropriate boxes.

Finally, click on the **OK** button.

**Resources values**

It is a sum of the numerical headings of the events resources. In this case, it is necessary to select the headings to totalise and to precise if the doubloon must be calculated twice.(cf. below **No duplicate**.

By **clicking on the button on the right**, the following window appears:

**Display format**

- Integer: Select 0 as value.
- Decimal : Select 0,00 as value.
- Integer percentage: Select 0% as value.
• Decimal percentage: Select 0,00% as value.

**Persistence**

The check box **Persistence** allows to define the control column as persistent.

c.f. **Heading persistence**

**No duplicate**

In the case of a calculation on resources values, this checkbox treat the case of several events of the same resource. If checked, the same heading will be counted only once.

**Thresholds definition**

The thresholds are indicators of goals overtaking.

c.f. **Thresholds**

**Display remainder**

This check box, if checked, displays the result in the form of a remainder between the target and the calculated value.

c.f. **Thresholds**

**Display in percentage**

This check box, if checked, displays the result in the form of a percentage of the calculated value compared with the target.

c.f. **Thresholds**

**Events filters**

The events filter allows to limit the calculation for each resource into certain events of this one.
It can be:

- a named filter,
- a customized filter which can be used only for this control column heading,
- or a current filter.

**Period**

The **Period** is the period on which the control column is applied: c.f. *Time period*

If an event is not entirely into the period, only the part of the event that matches the period is calculated.

**Type of intersection**

The **Type of intersection** is chosen between the following values:

- Intersect the period
- Cover the period
- Are included in the period
- Start in the period
- End in the period

**Clicking date**

The **Clicking date** option allows to choose the period with a click.

**Period according to the time**

This check box allows, if checked, to use the period defined above (only slipping period) and the mouse click. This click represents the fulcrum of the period.

**Modify a Control column heading**

The modification of a heading involves an important change in the planner's architecture. *It is a powerful act of setting which should not be made without consideration.*

(c.f. precautions to take when modifying the settings)
Modifying a heading can be done into the **Global Settings** panel.

The features can be modified (c.f. Create a heading) in the low part of the window and be validated by clicking on the **OK** button.

If it is not the right modification, click on the **Restore** button.

cf. Modify a heading

---

**Delete a control column heading**

The deletion of a heading involves an important change in the planner's architecture. 
**It is a powerful act of setting which should not be made without consideration.**
(c.f. precautions to take when modifying the settings)

cf. Delete a heading

<pagebreak>

**USE**

c.f. Use the headings

**Visualization**

These types of headings can be visualized as the other headings : c.f. View the headings

**Resources Color**

The resources can take the colors of the thresholds of a control column heading in the various views.

c.f. Thresholds

**Thresholds Constraints**

When an event is modified on the planner, the constraints on the thresholds of the control column are verified.
Important:

- If the heading is not persistent, the heading should be visible in the view.
- If the heading is persistent, it is not necessary to view this heading to launch the constraint.

If a warning constraint is not respected, the following message appears:

![Question]

The user can choose:

- to respect the constraint by clicking on the No button. The modification will not be applied.
- or not to respect the constraint by clicking on the Yes button (or Yes to All for all the events). The modification will be applied.

If a forbidden constraint is not respected, the following message appears:

![Error]

In this case, the user can not do anything, except clicking on the OK button. The modification of the event is not applied.

c.f. Constraints

Operation heading type

A control column heading can be used in a Operation heading type, if it is persistent.

c.f Operation Heading

Display totals in a resources view

In a resources view, in table mode, it is possible to display the totals of control column headings.

For this, you have to simply check the box “Display totals” in Edit display settings window of the resources view.
C.f. Resources view

Others functionalities

- Sort
- Identification heading
- Events Report
- Export Resources
- Export Events

Dimension, resource, calculation, display, heading, threshold

1), 2), 3), 4), 5), 6) conversion Jours vs Heures
Valuation item

DEFINITION

A Valuation item allows to assign one or several numeric values to every event.

It can be :

- amount
- mileage
- rate
- etc

A valuation item can be calculated in a fixed way or according to duration.

When several values are affected to an event, each one refers to a different valuation item.

SETTINGS

Create a valuation item

To create a valuation item, open the Global Settings panel > Right-Click on a Valuation item > Create a Valuation item.

The following window appears :
Fill in the different features and click on the **OK** button.

**Name**

It is the Name of the Valuation item.

**Description**

It is an optional description of the Valuation item.

**History**

It concerns the date, the hour of the last modification of the dimension or its headings. It concerns also the login of the user who did this modification.

This property is updated automatically.
**Global unit**

It is the unit in which the Valuation item must be converted.

**Basic unit**

It is the unit in which the Valuation item is expressed.

**Coefficient of conversion**

It is the coefficient of conversion of the basic unit to the global unit.

This coefficient allows to convert days into euros for example, or pallets into trucks.

**Display the coefficient**

Additional coefficients may be applied on working **types of periods**. It allows, for example, to define that working on Saturdays is counted as 150%.

This check box defines whether the valuation item needs a coefficient or not.

**Display the fixed value**

This check box defines whether the valuation item needs a fixed value or not.

**Display the time unit**

This check box defines whether the valuation item needs to show the time unit or not.

**Display the value per unit**

This check box defines whether the valuation item needs a variable value per unit (time unit,...) or not.
Coefficient

For each type of working periods, it is possible to precise additional coefficients that can be applied to the events which run through these period types.

For exemple, saturday work may be counted at 150%.

Assign a valuation item to a creation rule

After creating a valuation item, it is necessary to allocate it into an event creation rule.

To do so, specify its values in the definition window.

Modify a valuation item

The modification of a valuation item involves an important change in the planner's architecture. It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

To modify a valuation item, select it into the Global Settings. (c.f. Create a valuation item)

Delete a valuation item
The deletion of a valuation item involves an important change in the planner's architecture. It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

In the **Global Settings** panel > **Valuation item** > **Click** on the Valuation item > **Delete** to delete the Valuation item.

The following window appears:

- Click on **Yes** to definitely delete,
- Click on **No** to cancel.

<pagebreak>

**USE**

**Fill in the values of a valuation item**

To seize a value into a Valuation item, **Right-click** on an event > **Modify**.

The following window appears:
In the **Valuation** tab, seize the values into the **Value** column and Click on the **Validate** button.

There are six values for each valuation item.

c.f. [Calculation method of a valuation item](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/poste_de_valorisation)

Only the visible values can be seized. (cf. [Create a valuation item](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/poste_de_valorisation))

The potential values to seize are the following:

- **Time unit**
  - Day
  - Hour
  - Load in days
  - Load in hours
  - Of the event
- **Fixed value** (if visible)
- **Value per unit** (if visible)
- **Coefficient** (if visible)

The Total in basic unit is calculated automatically, as the Total in global unit.

The Total for all the valuation items of the event is also calculated automatically.

Finally, confirm by clicking on the **OK** button.

### Allocate a valuation item to an event

A Valuation item can be directly assigned to an event.

However, use this method only punctually. The assignement to a [creation rule](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/poste_de_valorisation) is preferable.

To assign a Valuation item to an event, **Right-Click on an event > Modify**.
The following window appears:

![Valuation Table]

Add an additional valuation item to an event

Click on the Add button > Select the appropriate Valuation item.

Then, fill in the values of the Valuation item. (c.f. Fill in the values of a valuation item)

Remove a valuation item to an event

Click on the Delete button > Select the appropriate Valuation item.

View a valuation item

The values of the Valuation items can be displayed:

- In the texts displayed on the duration bars of the events.
- In the events tooltips.
- Among the columns of an Events view.

Add a coefficient according to the period type

A Valuation coefficient can be added to a type of period.

This assignement is automatically made during the creation or modification of the events on the planner.(cf. Coefficients)

This coefficient applies only to variable valuation and no to fixed valuation.
Re-calculation of a valuation item

Splitt an event

Several events contain a valuation item and the fixed value is calculated by an *event creation rule*.

After splitting these events, the following message comes up:

![Question](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/poste_de_valorisation)

You can then choose:

- **Yes**: the fixed value of the valuation item is then smoothed in the new events according to their respective durations,
- **Yes to all**: same for all splitted events in the case of a split of multiple events,
- **No**: the fixed value of the valuation item is then kept in the new events according to their respective durations,
- **No to all**: same for all splitted events in the case of a split of multiple events,

Modify a resource

During modification of the *Numerical Heading* of a resource, if it is used by a *creation rule* to define a valuation item, the following message comes up:

![Question](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/poste_de_valorisation)

You can then choose:

- **Yes to all**: this new value is associated with all events on which the creation rule applies,
- **Yes from**: Same thing from the selected date in the following message:
• **No**: The events are not updated.

**Calculation method of a valuation item**

**Elementary case**

It concerns the case where the event crosses only a single type of period.

So be it:

- $Total$: the total value of the Valuation item,
- $C_c$: the global coefficient of conversion,
- $C_p$: the coefficient of the Valuation item,
- $V_f$: the fixed value of the Valuation item,
- $D_e$: the duration of the event,
- $V_u$: the variable value of the Valuation item per unity (time, load, etc.),
- $C_t$: the coefficient of the only crossed type of period.

The total value of the Valuation item is then calculated as below:

$$Total = C_c C_p \left( V_f + D_e V_u C_t \right)$$

**General case**

It concerns the calculation method which answers to all the cases, that there are one or several types of periods that are crossed by the event.

So be it:

- $Total$: the total value of the Valuation item,
- $C_c$: the global coefficient of conversion,
- $C_p$: the coefficient of the Valuation item,
- $V_f$: the fixed value of the Valuation item,
- $n$: the number of types of period that are crossed by the event,
- $D_{ei}$: the duration of the part of the event that crossed the type of period $<tex>i</tex>$,
- $V_{ui}$: the variable value of the part of the event that crossed the type of period $<tex>i</tex>$,
- $C_{ti}$: the coefficient of the type of period $<tex>i</tex>$.

The total value of the Valuation item is then calculated as below:
Total = \( C_c C_p \left( V_f + \sum_{i=1}^{n} D_{ci} V_{ui} C_{ti} \right) \)

**Use by another functionalities**

The Valuation items of the events are bound to be used by various summary tables:

- The **Control column heading**
- The **Event reports**
- The **Workload**
- The **Constraint**

Valuation, item, event
Period Type

DEFINITION

Type period are the entity which allow to define calendars.
It permits to associate a color or a ratio to hourly patterns and daily patterns.

SETTING

Create a Period type

In the Global Settings panel, Right click on Calendars > Period types > Create Period types.

The lower part is then activated:
Then, precise the characteristics of the Period Type and click on the **OK** bouton.

This setting is also accessible by an other entry point (c.f **Global Settings**).

The caractéristics of a Period type are the followings:

**Name**

This is the name of the Period type.

**Description**

This is the Period type optional description.

**Color**

The color of this Type period is chosen by selectin the [color palette](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/calendrier_type_de_periode).

c.f. **Color concept**

**Type**

The type is function of the daily/hourly events:

the period can be:

- Hourly
- Daily
- Hourly and Daily

**Worked**

This check box allows to specify whether the type of period is worked or not. (c.f. **Worked concept**)

If the box **worked** is checked, coefficients will be defined when setting up valuation items. (c.f **Valuation item**)

https://www.visual-planning.com/doc/en/3-definition_de_la_structure/calendrier_type_de_periode?print=true
**Modifiy a Period type**

The modification of a Period type involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

The modification of a Period type is made by selecting in the Global Settings panel. Then, it is necessary to modify the settings in the lower part of the window. (c.f. Create a Period type)

It is not possible to cancel the modification.

**Delete a Period type**

The deletion of a Period type involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

The deletion of a Period type is made by selecting in the Global Settings panel > Right click on the Period type > Delete.

It is not possible to delete a default Period type.

**ASSIGN A PERIOD TYPE**

The **Period type** is designed to be assigned to hourly and daily patterns.

it can also be assigned to the calendar of a resource.

**Assign to a hourly pattern**

It is necessary to define on twenty four hours the Period types that will constitute the hourly pattern.

C.f Period types used by hourly pattern
**Assign to a daily pattern**

This means defining the Period type over a week for each day constituting the daily pattern.

c.f. [Period types used for daily pattern](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/calendrier_type_de_periode)

**Assign to a planner period**

It is possible to change a resource calendar thanks to **Period types**.

It is made by **drag an drop** a Period type on a resource at a given date. The resource calendar is then duplicated as **customized** and modified.

**Calendar, period, type**
Calendars

DEFINITION

Some dates appear colored (gray by default) on the schedule: these are types of period which can be worked or not worked.

A Calendar assembles various types of period.

Several calendars can be defined:

- the Daily calendars show non-working days (weekends and days off);
- the Hourly calendars show non-working hourly period (in increments of 5 minutes).

All Calendars can be combined in a cyclical way or not, thanks to Hourly patterns or daily patterns.

Each event have the daily and hourly calendar of one of its resource.

SETTING

To set calendars, it is necessary to define and allocate several VISUAL PLANNING types of entities in the following order:

<table>
<thead>
<tr>
<th>Definition</th>
<th>Hourly Scale</th>
<th>Daily scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Definition of Period types</td>
<td>Definition of Period types</td>
</tr>
<tr>
<td>2</td>
<td>Definition of Hourly patterns</td>
<td>Definition of Daily patterns</td>
</tr>
<tr>
<td>3</td>
<td>Definition of Hourly calendars</td>
<td>Definition of Daily calendars</td>
</tr>
<tr>
<td>4</td>
<td>Assign Hourly calendars to Dimensions</td>
<td>Assign Daily calendars to Dimensions</td>
</tr>
<tr>
<td>5</td>
<td>Assign Hourly calendars to Resources</td>
<td>Assign Daily calendars to Resources</td>
</tr>
<tr>
<td>6</td>
<td>Assign Dimensions to Hourly calendar of the creation rule</td>
<td>Assign Dimensions to Daily calendar of the creation rule</td>
</tr>
</tbody>
</table>
USE

Calendars are useful on many levels:

Visualization

The calendars appear first as a visual indication: they are visible from the colored areas to which they are applied.

Drag and drop events

Calendars act on events.

When an event type is “Worked”, its behavior follows the calendar of its resources.

Example: Unable to position one day off on a Sunday, if:

- Events day off are “not worked”,
- the calendar is “worked” on Sunday.

Moreover, the event's duration does not take into account the non-worked time the event passes through.

cf. Working

Display the calendar of another dimension

When editing the duration of an event, if the calendar of the event is carried by a different resource than the dimension of the view, the calendar of the event appears superimposed.

Example 1: There is a schedule view of the dimension HR where the events require a resource of the dimension HR and a resource of the dimension Services

- The HR calendar: 7/7.
- The Services calendar: 5/7.
- The events are formed by the Services calendar.
- The view displayed is the HR's one.
1- Before the edition, the displayed calendar is the HR's one (7/7)

2- When the event is being edited, the calendar displayed is the Services' one.

3- After the edition, the visualization is the original one.

Exemple 2 - Video:
Calculate the duration of events

Hourly Calendars are also used to automatically calculate the number of hours spent daily in an event (or half-day).

cf. Duration

Calendar, hourly, daily, period, type

1) eventually
**Daily Pattern**

**DEFINITION**

This is a hourly set of *Daily pattern* period types.

A Daily pattern represents a week (from Monday to Sunday) on which each day has a type of period.

These daily patterns are combined in order to create *Daily calendars* which will be assigned to resources and creation rules.

**Example:**

A simple daily pattern with two period types: *Type 1* (Worked) et *Type 2* (Unworked).

<table>
<thead>
<tr>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
<th>Sunday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 2</td>
<td>Type 2</td>
</tr>
<tr>
<td>Worked</td>
<td>Worked</td>
<td>Worked</td>
<td>Worked</td>
<td>Worked</td>
<td>Unworked</td>
<td>Unworked</td>
</tr>
</tbody>
</table>
FUNCTIONAL REQUIREMENTS

To create Daily calendar, create the daily patterns that constitute it.

SETTINGS

Create a Daily Pattern

In the Global Settings panel, Click on Calendars > Right Click on Daily pattern > Create Daily pattern

The lower part is then activated:

Then it is necessary to precise:
Name

This is the Daily Pattern name

Description

This the optional Daily Pattern description

History

This is the last modification date/hour of the Daily Pattern and the user login who made it. This property is automatically updated.

Default daily pattern

This is the default daily pattern. It will be used if any daily pattern is defined.

Specific days

By clicking on the button on the right, the specific days window appears.

This window allows to set the specific days of the calendar and their period type.
It is possible to automatically predefine the specific days of a country by clicking on the **Add unworked days** button.

Specific days can be moved in another period (example: worked to unworked). To do so, select the specific day, copy it with a **Ctrl+C** and paste with a **Ctrl+V**.

A specific day can only be in a unique period type.

**Daily patterns**

These “additional” **Daily Pattern** allows to modify the original calendar and to use another patterns during a defined period.

They are defined in another window which is made of a list of periods having a daily pattern ordered by priority.

To access to this window, click on the button on the right.

In the window that appears:

- Add an additional pattern with the **Add** button,
- Delete an additional pattern with the **Delete** button.

For each additional pattern, precise:
**Start date**

It is the first applying day of the additional daily pattern (see below).

**End date**

It is the last applying day of the additional daily pattern (see below).

**Daily pattern**

It is the additional daily pattern which will replace the default daily pattern during the period above.

**Modify a Daily pattern**

The modification of a Daily Pattern involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*  (cf. precautions to take when modifying the settings)

The modification of Daily Pattern is realized by selecting the model in the **Global Settings** panel. Then, in the lower part of the window, it is necessary to change the settings (cf. Create a Daily Pattern).

This modification can be cancelled if VISUAL PLANNING is still opened. Events are then removed to their original position. (cf. **Undo / Redo**)

**Delete a Daily Pattern**

The deletion of a Daily Pattern involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*  (cf. precautions to take when modifying the settings)

Deleting a pattern is done via the **Global Settings** panel by selecting the Daily Pattern and then performing a **Right click on the Daily Pattern > Delete**.
You can not delete a default Daily Pattern.

Deleting a Daily Pattern is irreversible.

USE

Assign a Daily Calendar to a dimension

Each dimension has its default daily calendar.

This calendar will be a common calendar for all the resources of the dimension.

To assign this calendar, go to the settings of the dimension.

cf. Daily calendar of a dimension

Assign a Daily calendar to a resource

Each resource has its default daily calendar.

This calendar is the default calendar of its dimension (see above-mentioned).

However, it is possible to choose a different calendar for each resource. To do so, Right click on the resource > Modify > Settings tab.
Then:

- Choose another calendar into the list,
- or Modify the calendar by clicking on the button: 
- or Create a customized calendar by clicking on the button: 

It is also possible to modify the calendar of a resource via a drag&drop.

cf. Daily calendar of a resource

Assign a calendar to a creation rule

Each event follows the daily calendar of one of its resource.

The events creation rule allows to choose the dimension (and so the resource) which will lead the daily calendar.

The resources of the chosen dimension will lead the daily calendar of the event, even if the resource is modified.

cf. calendars

Calendar, daily
Daily Pattern

DEFINITION

This is a hourly set of Daily pattern period types.

A Daily pattern represents a week (from Monday to Sunday) on which each day has a type of period.

These daily patterns are combined in order to create Daily calendars which will be assigned to resources and creation rules.

Example:

A simple daily pattern with two period types: Type 1 (Worked) et Type 2 (Unworked).

<table>
<thead>
<tr>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
<th>Sunday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 1</td>
<td>Type 2</td>
<td>Type 2</td>
</tr>
<tr>
<td>Worked</td>
<td>Worked</td>
<td>Worked</td>
<td>Worked</td>
<td>Worked</td>
<td>Unworked</td>
<td>Unworked</td>
</tr>
</tbody>
</table>
SETTINGS

Create a Daily Pattern

In the Global Settings panel, Click on Calendars > Right Click on Daily pattern > Create Daily pattern

The lower part is then activated:

Then it is necessary to precise:

Name

This is the Daily Pattern name

Description
Yhis the optional Daily Pattern description

History

This is the last modification date/hour of the Daily Pattern and the user login who made it. This property is automatically updated.

Weekdays

It is necessary to define period types associated with weekdays.

By clicking on the right button, the following window opens:

![Editing weekdays]

cf. Period types

Modify a Daily pattern

The modification of a Daily Pattern involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

The modification of Daily Pattern is realized by selecting the model in the Global Settings panel, then in the lower part of the window, it is necessary to change the settings (cf. Create a Daily Pattern)

This modification can be cancelled if VISUAL PLANNING is still opened. Events are then removed to their original position. (cf. Undo / Redo)
Delete a Daily Pattern

The deletion of a Daily Pattern involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a pattern is via the **Global Settings** panel by selecting the Daily Pattern and then performing a **Right click on the Daily Pattern > Delete**.

You can not delete a default Daily Pattern.

Deleting a Daily Pattern is irreversible.

**USE**

Assign to a Daily Calendar

After setting the daily pattern, it is necessary to assign it to a daily calendar:

- Either as a default daily Pattern,
- Either as a Daily Pattern on an additional time period.

cf. Daily Pattern

Calendar, daily
Creation rule

DEFINITION

A creation rule is an entity that coordinates all the characteristics of the future events created.

Each event creation is led by the creation rules.

Furthermore, an event modification may be led by the same rules.

SETTINGS

Create a rule

To create an event creation rule, go to Global settings > Right-click on Events creation rule > Create events creation rule

The lower part is then activated:
Set the characteristics of the creation rule and validate by clicking on the **OK** button.

This setting is also accessible via another entry point (cf. **Global Settings**).

Fill in the following characteristics:

**Name**

It concerns the name of the events creation rule.

**Description**

It concerns an optional description of the events creation rule.
History

It concerns the date, the hour of the last modification of the events creation rule. It concerns also the login of the user who made this modification.

This property is automatically updated.

Priority

A Priority notion can be set to the events creation rules. This priority goes:

- from 1 (the highest priority)
- to 9 (the lowest priority)

The priorities allows to choose, among the events creation rules that matches the resources of the new event, the creation rule which will define the value of the current characteristic.

Finally, the default rule is applied for the undefined characteristics.

cf. Create an event

Edition window

This feature is active only when the check box Display the edit window is checked. You can choose a default type of Events Input Editor.

cf. Events Input Editor

Display the edition window

It allows to choose if the edition window of the event will be opened when creating the events that match the creation rule.

Calendars

The events creation rule can determine the dimension that will lead:

- the hourly calendar,
- the daily calendar.

For each of these types, the calendar is:
• Either undefined,
• Or defined according to a dimension.

Form

It is possible to assign a form to the events creation rule. Only one form can be assigned.

A list allows to choose a form among the existing forms.

It is also possible to assign no form or undefined.

Event type

The type of the future event (daily, half-daily, hourly) can be defined by the events creation rule.

This property can be:

• Either undefined,
• Or defined according to a heading of resource,
• Or defined with a determined value.

Duration

It is the default duration of the future event.

This duration can be:

• Either undefined,
• Or according to a heading of a dimension which is a numerical, a persistent operation, a persistent control column or a persistent event value,
• Or a fixed value,
• Or the result of a calculation between two headings of a dimension which are numericals, persistent operations, or persistent control column,
• Or According to the calendar and to the time scale used during creation. In this case, it is necessary to choose:
  ◦ the dimension that contains the calendar,
  ◦ the Period Type. The duration of the future event will be the sum of the duration of such period within the calendar.

Attention : In the case of a hierarchy where the Date of son events are Continuous or Similar, the durations of all sons events are managed by the duration of the father and not by the creation rule settings.
cf. *Duration*

**Working**

It allows to precise whether the future event will be a *Working* event or not.

The choice will be made between:

- Either *undefined*,
- Or according to a heading (it is a boolean heading),
- Or a boolean fixed *value* (check box).

cf. *Working*

**Start hour**

In the case of a hourly event, it is possible to precise its start hour.

This characteristic can be:

- Either *undefined*,
- Or according to a heading which is a *Hour Date heading*,
- Or a determined *value*.

This start hour is useful when creating an event on a *View* on which the *Time scale* is larger than the hour.

Example:

Creation of a hourly event in a view using a Day time scale.

**Type of load**

The property of the type of load can be:

- either *undefined*,
- or defined according to a heading which is a text,
- or defined by a *value* that can be:
  - Automatic,
  - in Day by day,
  - in hour by hour,
  - in hour,
  - in day,
in percentage.

cf. Load

Load

It is the value of the default load of the future event.

This load can be:

- Either **undefined**, 
- Or **according to a heading** of a dimension which is a **numerical**, a **persistent operation**, or a **persistent control column**, 
- Or a fixed **value**, 
- Or the result of a **calculation** between two headings of a dimension which are **numericals**, **persistent operations**, or **persistent control column**.

cf. Load

Automatic achievement

It is also possible to precise whether the future event will have an automatic achievement or not.

This characteristic can take the following values:

- Either **undefined**, 
- Or **according to a heading** of a resource (it is a boolean heading), 
- Or a determined boolean **value** (check box).

cf. Achievement

Resources

It is also possible to add another **resources** to the future event.

So, a resource per existing **dimension** can be chosen.
In case of conflict with the dependent resources, priority is given to the creation rule.

**Valuations**

It is possible to assign one or several valuation items and their values.

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item 1</td>
<td>[...]</td>
</tr>
<tr>
<td>Item 2</td>
<td>[]</td>
</tr>
</tbody>
</table>

By clicking on the button on the right, the following window appears:

Set the following values:

**Coefficient**

It is the coefficient of the valuation item. This property can be:

- Either undefined,
- Or according to a heading of a dimension which is a numerical, a persistent operation, or a persistent control column,
- Or a given value,
- Or according to the result of a calculation between two headings of a dimension which are numericals, persistent operations, or persistent control column.
The fixed value of the valuation item can be:

- Either **undefined**,  
- Or **according to a heading** of a dimension which is a **numerical**, a **persistent operation**, or a **persistent control column**,  
- Or a given **value**,  
- Or according to the result of a **calculation** between two headings of a dimension which are **numericals**, **persistent operations**, or **persistent control column**.

The Value per unit can be: * Either **undefined**,  
- Or **according to a heading** of a dimension which is a **numerical**, a **persistent operation**, or a **persistent control column**,  
- Or a given numerical **value**,  
- Or according to the result of a **calculation** between two headings of a dimension which are **numericals**, **persistent operations**, or **persistent control column**.

The Unit can be:

- Either **undefined**,  
- Or **according to a heading** (it is a text heading),  
- Or a given **value** which can be a:  
  - Day,  
  - Hour,  
  - Load in hour,  
  - Load in day,  
  - Of the event.

**cf. Valuation item**

**Modify a rule**

The modification of an events creation rule involves an important change in the planner's architecture. **It is a powerful act of setting which should not be made without consideration.**

(c.f. precautions to take when modifying the settings)
To modify an events creation rule, go to **Global settings > Click on the right creation rule**.

The lower part is then activated to allows to modify the characteristics.(cf. Create a rule)

**Delete a rule**

The deletion of an events creation rule involves an important change in the planner's architecture. **It is a powerful act of setting which should not be made without consideration.**

(cf. precautions to take when modifying the settings)

To delete a creation rule, go to **Global settings > Right-Click on the rule > Delete**.

It is not possible to delete the default creation rule.

**The deletion of a creation rule is irreversible.**

<pagebreak>

**ASSIGNMENT**

The events creation rule are assigned to the dimensions, ie all the resources of the dimensions.

For certain resources, the events creation rule can be modified.

**Assign to a dimension**

It concerns the default creation rule which is assigned by default to the whole resources of a dimension.

cf. **Dimension**

**Assign to a resource**

It is possible to modify a creation rule for certain resources.

cf. **Resource**
USE

Event creation

When creating an event, the following process is established:

1. Taking the resources of the event into account:
   - resources of the intersection. Those which allow the drag&drop.
   - resources which depend on the resources heading types.
2. Application of the creation rules according to the group of associated resources.
3. Verification of the conformity of the hierarchy of the resources of the event.
4. Verification of the potential constraints.

The creation rules are applied, item by item, according to the priority of the creation rules of the resources.

cf. Create an event

Example 1 - Priorities between creation rules:

Let:

- **CR1**: the creation rule which priority is 1. This rule only defines:
  - the *Hourly* type,
  - a duration equals to *5H00*.
- **CR2**: the creation rule which priority is 2. This rule only defines:
  - the *Hourly* type,
  - a duration equals to *2H00*,
  - and a start hour equals to *10H00*.
- **Default rule**: the default creation rule of the planner.
- **R1D1**: the resource 1 of the dimension *D1* which have any resource heading type. This resource have the creation rule **CR1**.
- **R1D2**: the resource 1 of the dimension *D2*. which have any resource heading type. This resource have the creation rule **CR2**.

A drag&drop of **R1D2** on the schedule of **R1D1** induces the creation of an event with the following properties:

- Hourly type -> from CR1
- Duration equals to 5h00 -> from CR1
- Start hour equals to 10H00 -> from CR2
- The other properties -> from the **Default creation rule**

Thus:
### Example 2 - Addition of a resource when creating an event

Let:

- **Row 1**: A resource of the dimension $D_1$,
- **Icon 1**: A resource of the dimension $D_2$,
- **Color 1**: A resource of the dimension $D_3$,
- **CR**: The creation rule which add the resource *Color 1*.

The creation rule *CR* is allocate to the *Icon 1*.

The creation of an event by a drag&drop of the *Icon 1* on *Row 1* at a given date implies that the created event will have:

- **Row 1**
- **Icon 1**
- and **Color 1**

### Event Modification

When an event is re-allocated on the planner, this one will combine the properties of the existing events creation rules. These properties may act on:

- the valuation;
- the hourly calendar;
- the daily calendar;
- the duration of the event;
- the load of the event.

The **creation rules** works on the assignement of the resources concerning the properties that belong to the resource:

- the **calendars**
- the **valuation items**
- the duration, load...according to a heading of the dimension.

**Rule, creation, event, modification**
Hourly Calendar

DEFINITION

Hourly calendar is a part of the schedule. It can be made by one or more hourly patterns.

It defines a schedule configuration for a resource.

A Hourly calendar is composed of working and/or non-working time.

The Hourly calendar also allows the visual representation of the different types of periods for the schedule.

For example: the grey colour for night hours.

FUNCTIONAL REQUIREMENTS

To create Hourly calendar, create the hourly patterns that constitute it.

SETTINGS

Create a Hourly Calendar

Create a Hourly calendar

In the Global Settings panel > Right Click on calendar > Create Hourly calendar.

The lower part is activated:
Details of the Hourly calendar have to be completed, then confirm by clicking on OK button.

These settings are also accessible by another entry point (cf. Global settings).

Characteristics of Hourly calendars are the following:

**Name**

This is the Hourly calendar name.

**Description**

This is the Hourly calendar optional description.

**History**

This is the Hourly calendar last modification hour and the user login who had made the last change.

It is an automatically update information.
**Default Hourly Pattern**

For each day of the week, this is the hourly pattern that will be taken if no other additional hourly pattern is added.

When adding a specific Hourly pattern, the default pattern will be applied when the additionnal template is not precised on periods.

**Specific Hourly Patterns**

These patterns are used to modify the calendar in order to replace the default pattern of the schedule during a defined period.

They are defined in another window made of period lists which have specific hourly patterns ordered by priority.

To access them, simply click on the right button:

The following window opens:

![Assignment of hourly patterns](image)

Over one year, a Hourly calendar can be edited for each day.

You can change year thanks to the list in the upper left corner.

As for events, it is possible to:

- Drag and drop hourly calendars on periods,
- Extend them,
- Reduce them.

By right-clicking on the calendar, you can:

- Modify,
• Repeat,
• Assign,
• Cancel.

Create a non-working hourly calendar

It is not possible to create a hourly calendar which is entirely non worked.

To avoid that, the following message appears when validating the calendar:

Modify a Hourly Calendar

The modification of a Hourly Calendar involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

It is possible to modify a calendar:

• either in the Global settings (cf. create a Hourly calendar),
• either (schedule view)via a drag and drop on a calendar or on a pattern period on a resource at a given date.

The modification of a calendar can still be canceled if VISUAL PLANNING remained open. Events are then returned to their original position. (cf. Undo / Redo)

Delete a Hourly Calendar

The deletion of a Hourly Calendar involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)
Deleting a calendar can be done via the **Global Settings** panel by selecting the calendar schedule and then performing a **Right click on the calendar > Delete**.

You can not delete a default Hourly Calendar.

**Deleting a Hourly Calendar is irreversible.**
USE

**Assign a Hourly Calendar to a dimension**

Each dimension have a default Hourly Calendar.

This calendar is defined for each resource of a dimension if there is no other calendar defined.

To assign this calendar, go into *dimension's settings*.

cf. *dimension's Hourly Calendar*

**Assign a Hourly Calendar to a resource**

Each resource have a default Hourly Calendar.

It is the default one assigned to the dimension.

It is possible to select a different calendar for each resource.

There are several ways to proceed:

- By a Drag and Drop,
- In the properties window of the resource,
- In the context menu of the resource.

cf. *Modify the calendar of a resource*

**Assign a Hourly Calendar to a creation rule**

Each event follows the Hourly Calendar of one of its resources.

The event creation rule permits to specify the dimension (and so the resource) that lead the Hourly Calendar.

Resources of the chosen dimension will define the event's Hourly Calendar, even if a resource changes.

cf. *Creation rule calendar*

Hourly, calendar
From: https://www.visual-planning.com/doc/ - VISUAL PLANNING 5.3 DOCUMENTATION

Permanent link: https://www.visual-planning.com/doc/en/3-definition_de_la_structure/calendrier_horaire

Last update: 2013/09/05 09:58
Hourly Pattern

DEFINITION

This is a hourly set of period types.

A Hourly pattern represents a day of twenty four hours (midnight to midnight) on which are located one or several hourly period types.

These Hourly patterns are then combined to make hourly calendars which will be assigned to resources, or creation rules.

Example :

A hourly pattern can be composed of two period types:

- Type 1 (Worked),
- Type 2 (Unworked).

<table>
<thead>
<tr>
<th>From 00h00 to 08h00</th>
<th>From 08h00 to 17h00</th>
<th>From 17h00 to 00h00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type 2</td>
<td>Type 1</td>
<td>Type 2</td>
</tr>
<tr>
<td>Unworked</td>
<td>Worked</td>
<td>Unworked</td>
</tr>
</tbody>
</table>

This hourly pattern can be applied from Monday to Friday.
SETTINGS

Create a Hourly Pattern

In the Global Settings panel, Click on Calendars > Right Click on Hourly pattern > Create Hourly pattern.

The lower part is then activated:

It is necessary to precise the hourly pattern characteristics, then click on the OK button.

These settings are also accessible by another entry point (cf. Global Settings).

The different characteristics are the following:

Name
This is the name of the hourly pattern.

**Description**

This is the optional description of the hourly pattern.

**History**

This is the last modification date/hour of the hourly pattern and the user login who made it.

This property is automatically updated.

**Periods**

Periods allow to add different period types in a day of 24 hours (cf. Period type)

As for the events:

- Drag and Drop period types over periods,
- Extend them,
- Reduce them.

**Modify a Hourly Pattern**

The modification of a Hourly Pattern involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

The modification of Hourly Pattern is realized by selecting the model in the Global Settings panel, then in the lower part of the window, it is necessary to change the settings (cf. Create a Hourly Pattern)
This modification can be cancelled if VISUAL PLANNING is still opened. Events are then removed to their original position. (cf. Undo / Redo)

Delete a Hourly Pattern

The deletion of a Hourly Pattern involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a pattern is done via the Global Settings panel by selecting the Hourly Pattern and then performing a Right click on the Hourly Pattern > Delete.

You can not delete a default Hourly Pattern.

Deleting a Hourly Pattern is irreversible.

USE

Assign to a Hourly Calendar

After setting the hourly pattern, it is necessary to assign it to a hourly calendar:

• Either as a default Hourly Pattern,
• Either as a Hourly Pattern on an additional time period.

cf. Hourly Calendar

Calendar, hourly
Event Value Heading

DEFINITION

This is a dimension heading type

A heading of this type can associate to a resource, a value of one of its events.

This value can be:

- The start date
- The end date
- The duration in hours
- The duration in days
- The load in days
- The load in hours
- The load
- The name of a resource (identification headings)
- A heading of the form
- A valuation item
- The valuation item total
- The creation date
- The last modification date
- The login of the user who made the creation,
- The login of the user who made the last modification.

SETTING

Create a heading

To create a Heading, you must go to Global Settings panel:

- Right click on the chosen dimension's name > Create heading
- or Right click on the chosen form's name > Create heading
- or Right click on the chosen name's heading > Create heading
The lower part of **Global Settings** is then activated.

Specify the characteristics of the heading, then confirm by clicking **OK**.
This setting is also accessible by another entry point (c.f Global Settings).

Characteristics of an Attachment heading are the following:

**Name**

This is the heading's name.

**Description**

This is the heading's optional description.

**Type**

The type is *Event value*.

**Persistence**

This box, if it is checked, defines the heading as persistent.

c.f. Persistence heading

**Editable**

This box, if it is checked, allows to modify the event value which is represented directly. The box takes the value from the corresponding resource heading. c.f. Modify the heading value

**Event value**

This is the event value to represent in the heading.

- Event - Start date,
- Event - End date,
- Event - Duration in hours,
- Event - Duration in days,
- Event - Load in days,
- Event - Load in hours,
• Event - Load,
• Resource name (Identification headings)
• Resource headings (except multi-line, boolean and non persistent)
• Forms - Headings,
• Valuation item - Total,
• Total of valuation items,
• History - Creation date,
• History - Modification date,
• History - Created by,
• History - Modified by.

**Event**

This is to select, depending on its start date, the event in the set defines in the filter below.

• the **First** of all
• or the **Last** of all

**Display format**

This is the way to visualise this heading in all VISUAL PLANNIG's window.

**Scheduling**

This is the criteria which defines the **first** or the **last** event. (c.f. **Event** above)

Possible choices are:

• Start date
• End date
• Creation date
• Modification date

**Event filter**

This filter allows to define the event type to take in consideration in the heading.

This can be:

• an existing **named filter**,  
• or a **customized** filter for this heading.
**Period**

The **Period** is the period on which the control column is applied: c.f. Time period

If an event is not entirely into the period, only the part of the event that matches the period is calculated.

**Type of intersection**

The **Type of intersection** is chosen between the following values:

- Intersect the period
- Cover the period
- Are included in the period
- Start in the period
- End in the period

**Clicking date**

The **Clicking date** option allows to choose the period with a click.

**Period according to the time**

This check box allows, if checked, to use the period defined above (only slipping period) and the mouse click. This click represents the fulcrum of the period.

**Modify a heading**

The modification of a Heading involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*

(c.f. precautions to take when modifying the settings)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The following lower part is then activated:

Then it is necessary to modify the characteristics (c.f Create a heading), then Validate by clicking on
the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

c.f. *Modify a heading*

## Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*

(c.f. *precautions to take when modifying the settings*)

**Deleting a heading is irreversible.**

c.f *Delete a heading*
USE

c.f Heading's use

Visualization

These heading's are visualized as all the others: c.f heading's visualization

Modify an event

For a given resource, the modification of an event is linked to this heading. The heading value is then automaticaly modified.

Modify a heading value

If the box editable is checked, the modification of this heading also modifies the event which is linked to the heading by the heading value.

Use by other features

- Sort
- Identification heading
- Events report
- Export Resources
- Export Events

Heading, event
**Time Period**

**DEFINITION**

In VISUAL PLANNING predefined **Time Period** is a set of days defined by:

- a relative or fixed start date,
- a relative or fixed end date.

A Time Period can be **worked** or **unworked**.

Default predefined Time periods exist (Today, This month, This week, Previous month, All the planner, ...).

It is also possible to define new Time periods to complete the list.

**SETTING**

**Default predefined time periods list**

All default predefined time periods are the following:

- Today
- This month
- This semester
- This quarter
- This year
- This fortnight
- This week
- Tomorrow
- Yesterday
- Previous year
- Next week
- Previous week
- Next month
- Previous month
- All the planner

Example: *This month means from the first day of the current month to the last day of the current month.*
Create a Time Period

In Global Settings, Right click on Time period > Create Time period

The lower part is then activated:

Then, precise the characteristics of the Time period and click on the OK bouton.

This setting is also accessible by an other entry point (c.f Global Settings).

The characteristics of a Time period are the followings:

**Name**

This is the Time period name.

**Description**

This is the Time period optional description.
History

This is the Daily calendar date, last modification hour and the user login who had made the last change.

It is an automatically update information.

Définition

By clicking to definition, the following window is then activated:

![Time period window](image)

Then, it is possible to define the start and the end of Time period

The start and end of the period are defined the same way.

It is possible to define Time periods with:

- Relative Start and End
- Fixed Start and End
- Fixed Start and Relative End
- Relative Start and Fixed End

Fixed Date

In this case, it is necessary to specify a date and hour.

This date is independent of when the Time period is used.
Relative value

In this case, it is necessary to define a date on when the Time period is used.

Each rolling period is defined as:

- A **Relative value**: A number. The reference period is represented by the number 0.
- A **Relative unit**: Hour, Day, Week, Month...

Examples:

<table>
<thead>
<tr>
<th>Time periods</th>
<th>Current date (of the functionality date of use)</th>
<th>Signification</th>
</tr>
</thead>
<tbody>
<tr>
<td>The fixed date of 21/01/2011</td>
<td>whatever the current date</td>
<td>always means the 21/01/2011</td>
</tr>
<tr>
<td>The relative value 1 day</td>
<td>at the date of 31/12/2011</td>
<td>means the 31/12/2011</td>
</tr>
<tr>
<td>The relative value 1 day</td>
<td>at the date of 02/01/2012</td>
<td>means the 02/01/2012</td>
</tr>
</tbody>
</table>

Duplicate a Time period

It is possible to duplicate an existing Time period:

- In **Global Settings > Right Click on Time period > Duplicate**

The new Time period has the same name with the suffix - *Copy*:

Then, it is necessary to define the characteristics of the new Time period. (c.f. Create a Time period)
Modify a Time period

The modification of a Time period involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

To modify a Time period:

• A Click on Time period to modify,
• then Click on settings to modify
• Modify the settings.

(c.f. Create a Time period)

It is impossible to modify the VISUAL PLANNING default Time period. (c.f. List see above)

Delete a Time period

The deletion of a Time period involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (c.f. precautions to take when modifying the settings)

To delete a Time period:

• Either in Global Settings > Right click on the Time period to delete > Delete

The following window appears:
To confirm or not the deletion click on **YES** or **No**.

It is not possible to delete a default Time period in VISUAL PLANNING

&pagebreak

**USE**

This section describes the use of a Time period by other functionalities of VISUAL PLANNING.

**Events filter**

It is possible to use a Time period as a criteria of events filter

Two attributes:

- Start date
- End date

It is also possible to do events filter with a criteria on a day.
**Control column**

In a *control column* heading, it is necessary to define the Time period on which the control will be applied.

The Time period is in the tab *Filtering events > period > choice of the period* (this month, this year,...)
Use by other features

- Events reports
- Prints
- Export Events
- Schedule view

Time, period
Hour Date heading

DEFINITION

This is a type of heading for a dimension or a form.

A date/hour heading has a display format and eventually a default value.

SETTINGS

Create a heading

To create a Heading, go to Global Settings panel:

- Right click on the chosen dimension's name> Create heading
- or Right click on the chosen form's name> Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

These settings are also accessible by another entry point (c.f **Global Settings**).

Characteristics of **Hour Date Heading** are the following:

**Name**

This is the heading's name.

**Description**

This is the heading's optional description.

**Heading type**

The **Hour Date** type is defined. This can not be modified.

**Index**
If this box is checked, the heading is indexed in the database.

**Warning**

Index the headings is really useful in some cases.

We strongly recommend to contact the Support of STILOG I.S.T. whether manipulations of this type are needed.

- Email : support[at]stilog[.]com

**Default Value**

A default value can be used to the creation of a new resource (resource heading case) or event (heading form case). It is possible to leave empty this value.

**Prohibit default value**

If this box is checked, the user must fill the heading value but he can't use the default value.

**Today creation date**

This box, if checked, allows to fill the heading with the creation date of the resource.

**Display format**

This is the heading visualization in VISUAL PLANNING.

Formats are the following:

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>dd/MM/yyyy</td>
<td>15/03/2010</td>
</tr>
<tr>
<td>EEEE dd MMMM yyyy</td>
<td>Monday 15 March 2010</td>
</tr>
<tr>
<td>MM/dd/yy</td>
<td>03/15/10</td>
</tr>
<tr>
<td>yyyy-MM-dd</td>
<td>2010-03-15</td>
</tr>
<tr>
<td>dd/MM/yyyy HH:mm</td>
<td>15/03/2010 20:50</td>
</tr>
<tr>
<td>dd/MM/yyyy h:mm a</td>
<td>15/03/2010 8:50 PM</td>
</tr>
<tr>
<td>EEEE dd MMMM yyyy HH:mm</td>
<td>Monday 15 March 2010 20:50</td>
</tr>
<tr>
<td>EEEE dd MMMM yyyy h:mm a</td>
<td>Monday 15 March 2010 8:50 PM</td>
</tr>
</tbody>
</table>
Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*
(cf. *precautions to take when modifying the settings*)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The following lower part is then activated:

Then it is necessary to modify the characteristics (cf. *Create a heading*), then Validate by clicking on the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*
(cf. *precautions to take when modifying the settings*)
Deleting a heading is irreversible.

cf. Delete a heading

USE

cf. Utilisation des rubriques

Visualization

These headings are visualized as all the others: cf. heading's visualization

Enter a value

A Hour Date Heading is used as Small Calendar

Use by other features

- Sort
- Identification heading
- Events Report
- Export Resources
- Export Events

Heading, date, hour
Operation Heading - Duration

DEFINITION

It is a heading of a dimension or a form

Dimension heading

A Duration Operation Heading allows to calculate the difference between two date headings of the same dimension, for each resource.

This heading can be persistence or not

It is possible to set thresholds (objectives) like the calculated headings.

Form heading

A Formula Operation Heading allows the calculation of the difference between two dates of an event:

- Form heading
- Dimension heading
- Event start date
- Event end date

It is not possible to apply thresholds (objectives).

REQUIREMENTS

Form

A form duration operation heading may use one or two headings of the same form with a type as follows Date hour,
Dimension : Non persistence heading

A non persistent duration operation heading needs one or two headings of the same dimension with a type as follows:

- Hour date,
- or Event value (persistence or not).

cf. Persistence

Dimension : Persistence heading

A persistent duration operation heading needs one or two headings of the same dimension with a type as follows:

- Date hour,
- or Event value persistence.

cf. Persistence

SETTINGS

Create a duration operation heading

In the Global Settings menu:

- Right click on a dimension > Create heading > Operation,
- Right click on a form > Create heading > Operation.
The following window opens:

It is necessary to field the informations on this new heading, then click OK

The characteristics of a **Duration Operation Heading** are:
Name

It is the name of the heading.

Description

It is an optional description of the heading.

Type of heading

The type of the heading is **Operation**. This feature, selected previously, it is not modifiable.

Calculation type

Select **Duration**.

The other type is explained on the following page: **Operation Heading - Formula**

Heading 1

It is the first heading used for the calculation.

The type of this heading should be selected according to the **requirements**.

Dimension: it is possible to select **Now** i.e. the current date and hour of the system

Form: it is possible to select **Start date** or **End date** of the event.

Heading 2

It is the second heading used for the calculation.
The type of this heading should be selected according to the requirements.

Dimension: it is possible to select **Now** i.e. the current date and hour of the system

Form: it is possible to select **Start date** or **End date** of the event.

**Unit**

It is the unit of the result.

This unit could be:

- Days,
- Hours.

The result of this calculation is decimal.

For example: 0.5 hours means 30 minutes.

**According to the calendar**

This single choice list provides the following calendar choices:

- Empty: 24/24h - 7/7j,
- Name of the dimension of the heading: the calculation is done on the **working** days of the resource calendar,
- Name of a resource heading of the dimension: the calculation is done on the **working** days of the dependant resource calendar.

cf. **Conversion days into hours**

**Display format**

It is the way to show this operation heading in the different screens of VISUAL PLANNING.

Four choices are possible:

- Enter: Select the value 0
- Decimal: Select the value 0.00
- Enter percent: Select the value 0%
- Decimal percent: Select the value 0.00%
Set the thresholds

The thresholds are colored indicators to show if an objective has exceed or not.

This property is not available for the Operation headings of a form.

cf. Heads with thresholds

Display reminder

If checked, this box allows to display the result as a balance between the objectif and the calculated value.

If any objective has been defined, this box is grey without any possibility to check.

This property is not available for the Operation headings of a form.

cf. Heads with thresholds

Display in percentage

This box allows, if checked, to display the result as a percentage of the value calculated in relation to the objective.

If any objective has been defined, this box is grey without any possibility to check.

This property is not available for the Operation headings of a form.

cf. Thresholds

Persistence

The checkbox **persistence** allows the heading to be persistence.

This box is grey, without any possibility to check, if at least one of the headings used for the calculation (Heading 1 and/or Heading 2) is not persistence.
This property is not available for the Operation headings of a form.

cf. Persistence

**Modify a heading**

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(c.f. precautions to take when modifying the settings)

To modify a heading, **Global settings > Select the dimension > Select the heading**

The feature's windows opens.

Modify the characteristics (cf. Heading), then clic OK.

If the modification should not be done, click Restore.

cf. Modify a heading

**Delete a heading**

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(c.f. precautions to take when modifying the settings)

Deleting a heading is irreversible.

c.f Delete a heading

USE

cf. Using headings
Visualization

These heading's are visualized as all the others: c.f. heading's visualization

Calculation

The result of the heading Numeric Duration is the result of the following calculation.

The numeric operation heading is: \( \text{Result} = \text{Heading 2} - \text{Heading 1} \)

Example 1 : with all the headings daily defined

<table>
<thead>
<tr>
<th>Heading 2</th>
<th>Heading 1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/03/2012</td>
<td>10/03/2012</td>
<td>1 J</td>
</tr>
</tbody>
</table>

Example 2 : with all the headings hourly defined

<table>
<thead>
<tr>
<th>Heading 2</th>
<th>Heading 1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/03/2012 00:00</td>
<td>10/03/2012 12:00</td>
<td>12 H</td>
</tr>
</tbody>
</table>

Color of the resources

The resources can take the threshold's colors of the operation heading in the different views.

c.f. Thresholds

Constraints of the thresholds

When an event is modified, the constraints of the operation heading are verified:

If a warning constraint is not verified, the following message appears:
When an event is modified, the thresholds of the operation heading are verified.

The user can choose:

- Respect the constraint > Click **No**. Any modification is done.
- Do not respect the constraint > Click **Yes**. The modification is done.

The button **Yes to all** allows to not respect the several constraint in the case that several constraints are launched.

If an imperative constraint is launched, the following message appears:

In this case, the user can not do anything, except click **Ok**. The modification of events is not done.

cf. **Constraints**

**Using in others operation headings**

An operation heading can be used in other operation headings.

cf. **Requirements**

**Display totals in a resources view**

In a resources view, in table mode, it is possible to display the totals of operation headings.

For this, you have to simply check the box “Display totals” in Edit display settings window of the resources view.

C.f. **Resources view**
Using in others features

- Sort
- Identification headings
- Event report
- Export Resources
- Export Events

Heading, numerical, calculation, thresholds, resource, operator, operation

From:
https://www.visual-planning.com/doc/-VISUAL-PLANNING-5.3-DOCUMENTATION

Permanent link:
https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_de_type_operation_duree

Last update: 2014/08/18 13:35
Operation Heading - Formula

DEFINITION

This is a heading type of dimension or a form

Dimension

A Formula Operation Heading allows a calculation between two or several headings of the same dimension, for each resource.

A heading of this type can be persistent or not.

It is possible to apply thresholds (objectives) as for calculated headings.

Form

A Formula Operation Heading allows a calculation between two or several headings of the same form, for each event.

A heading of this type is always persistent.

It is not possible to apply thresholds (objectives).

REQUIREMENTS

Heading non-persistent

A non persistent formula operation heading needs one or two headings of the same dimension with a type as follows:

- Numerical,
- Control Column (persistent or not),
- Operation (persistent or not),
- or Event Value (persistent or not).

c.f. persistence
# Heading persistent

A persistent formula operation heading needs one or two headings of the same dimension with a **type** as follows:

- Numerical,
- Persistent Control Column,
- Persistent Operation,
- or Persistent Event Value.

**cf. persistence**

A persistent formula operation heading needs one or two headings of the same form with a **type** as follows:

- Numerical,
- Operation.

## SETTINGS

### Create a formula operation heading

In the **Global Settings** panel:

- **Right click on a dimension > New heading > Operation,**
- **Right click on a form > New heading > Operation.**
The lower part is then activated:

```
<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Heading type</td>
</tr>
<tr>
<td>Calculation type</td>
</tr>
</tbody>
</table>
```

The next step is to specify the characteristics of this new heading, then click the **OK** button.

The characteristics of a formula operation heading are:
Name

This is the name of this heading.

Description

This is the optional description of the heading.

Type

The type is Operation. This feature, previously selected, is not editable.

Calculation type

You must choose the type of operation: Formula

The other type of operation is: Operation Heading - Duration

Formula

To capture the headings that will be the terms of the formula, simply right click in the formula window > select the heading.

Then, enter the operator.
It is necessary to set the formula.

**Dimension**

To do this, it is possible to use:

- **Headings**
- **Operators**
- **Constants**

**Form**

To do this, it is possible to use:

- **Headings**
- **Operators**
- **Constants**
- Calculation of the event: Event-Number, Event-Duration in Hours, Event-Duration in Days, Event-Load in Hours, Event-Load in Days.

If a syntax error is detected after entering the formula, the following error message appears:
Headings

Right click in the window > Select the heading :

- numerical or calculated headings from the same dimension or form,
- numerical or calculated headings from a dependant resource,

These headings must be according to the Requirements above.

Operators

These are the operators used for the calculation.

The choices are:

- Brakets : ()
- Addition : +
- Substraction : -
- Multiplication : *
- Division : /
- The absolute value of X : abs(X)
- Integer round of X : round(X)
- The upper integer value of X : ceil(X)
- The less integer value of X : floor(X)
- The minimum value between a and b: min(a,b)
- The maximum value between a and b: max(a,b)

cf. Calculation see below

Constants

A constant is an integer or decimal.

To use constants when setting the formula, just enter them directly in the window.

Display format

This is the way to see this heading type operation in different windows VISUAL PLANNING.

Four options are available:
• Integer : Select the value 0
• Decimal : Select the value 0,00
• Percentage full : Select the value 0%
• Percentage decimal : Select the value 0,00%

**Thresholds definition**

The thresholds are colored indicators exceeded thresholds or not.

This property is not available for the Operation headings of a form.

cf. **Thresholds**

**Display remainder**

This box permits, if checked, to display the result as a balance between the objective and the calculated value.

This box is grayed out, without the possibility of the check, if no targets are set.

This property is not available for the Operation headings of a form.

cf. **Thresholds**

**Display in percentage**

This box permits, if checked, to display the result as a percentage of the calculated value in relation to the objective.

This box is grayed out, without the possibility of the check, if no targets are set.

This property is not available for the Operation headings of a form.

cf. **Thresholds**

**Persistence**

The check box sets the persistence section as persistent.

This box is grayed out, without possibility of check, if the headings used in calculation (Heading 1 and/or Heading 2) are not persistent.

This property is not available for the Operation headings of a form. On this case, the heading is
always persistent.

cf. **Persistance de rubrique**

---

**Modify a heading**

The modification of a heading changes the architecture model of planning.
It is a strong act of setting, should not made without reflection.
(cf. **precautions to take when modifying the configuration**)

The modification of a heading is done by selecting the heading in the **Global Settings** panel.
The lower part of the window is then activated.
It is to modify the characteristics (cf. **Création d'une rubrique**), then click the **OK** button.
If the change should not be taken into account, you must click on the **Restore** button.
(cf. **Modify a heading**

---

**Delete a heading**

Deleting a heading changes the architecture model of planning.
It is a strong act of setting, should not be made without reflection.
(cf. **precautions to take when modifying the configuration**)

Deleting an item is irreversible.
(cf. **Delete a heading**
USE

c.f. Use a headings

Visualization

The headings of this type are viewed as all the headings
cf. visualization of headings

Calculation

The value of the heading type **operation** is the result of all calculation using one of the operators.

Examples

Result=round(Heading1)

<table>
<thead>
<tr>
<th>Heading1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,5</td>
<td>1</td>
</tr>
</tbody>
</table>

Result=ceil(Heading1)

<table>
<thead>
<tr>
<th>Heading1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,3</td>
<td>1</td>
</tr>
</tbody>
</table>

Result=floor(Heading1)

<table>
<thead>
<tr>
<th>Heading1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,5</td>
<td>1</td>
</tr>
</tbody>
</table>

Result=min(Heading1,Heading2)

<table>
<thead>
<tr>
<th>Heading1</th>
<th>Heading2</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,5</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Result=max(Heading1,Heading2)

<table>
<thead>
<tr>
<th>Heading1</th>
<th>Heading2</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,5</td>
<td>1</td>
<td>1,5</td>
</tr>
</tbody>
</table>
Color resources

Resources can take the colors of the thresholds of a heading type operation in different views.

c.f. Thresholds

Constraints Threshold

When changing the schedule of events, the constraints of the thresholds of Operation Heading are checked:

If a warning type constraint is not met, the following message appears:

![Question](image)

The user can choose:

- to respect the constraint by clicking the **No** button. The change will not be considered.
- or not to respect it by clicking **Yes**. The modification will be considered.

The **Yes to all** button allows to not respect none of the constraint if several are applied.

If an imperative constraint is not respected, the following message appears:

![Error](image)

In this case, the user can do nothing, except click on the **OK** button. The change of events that caused this message into account.

cf. Constraints
Using in other operation headings

If **persistente**, an operation heading may be used in the calculation of another entry of type Operation.

Display totals in a resources view

In a resources view, in table mode, it is possible to display the totals of operation headings.

For this, you have to simply check the box “Display totals” in Edit display settings window of the resources view.

C.f. Resources view

Use by other features

- Sort
- Identification headings
- Events Report
- Export Resources
- Export Events

Heading, calculation, threshold, resource
Single Choice List Heading

DEFINITION

This is a type of heading for a dimension or a form.

It is necessary to define a list of values. This list can be sorted alphabetically or manually. The value taken by a resource (resource's heading) or an event (form's heading) is unique among the list.

It is possible to define a default value.

The use of Autofiltering (cf. AutoFilter) is allowed.

SETTINGS

Create a heading

To create a Heading, you must go to Global Settings panel:

- Right click on the chosen dimension's name> Create heading
- or Right click on the chosen form's name> Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

These settings are also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Multiple Choice List Heading** are the following:
Name

This is the heading's name.

Description

This is the heading's optional description.

Heading type

The **Single Choice List** type is defined. This can not be modified.

Index

If this box is checked, the heading is indexed in the database.

Warning

Index the headings is really useful in some cases.

We strongly recommend to contact the Support of STILOG I.S.T. whether manipulations of this type are needed.

- Email : support[at]stilog[.]com

Default Value

A default value may be used to create a new resource (resource heading) or event (form heading).

Prohibit default value

If this box is checked, the user must fill the heading value but he can't use the default value.

Autofiltering
If it is checked, this box allows to define this heading as being subject to autofiltering.

cf. Autofilter

**List of Value**

The possible values are the following:

![List of Value](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_de_type_liste_a_choix_unique)

**Add a value in the list**

To add a value in the list, simply click on **Enter a value**.

**Modify an element of the list**

To change the value of a list, simply click on the value and modify the existing value.

**Delete an element of the list**

To delete an element, simply click on the value, and select the **Delete** button.
Sort the elements of the list

To automatically sort all values in the list, simply click on the Sort button.

It is possible to make an manual sort by using the blue arrows.

This sort is also the one used to sort a view according to this heading.

Refresh according to existing values

This feature is particularly useful when converting a text field in a single-choice list.

By clicking on the Refresh button, the values of the choice list are updated in existing resources according to the values of this heading.

Paste elements from clipboard

After making a Copy in an external application, it is possible to paste the entire list by clicking on the Paste button. The values are added as new elements in the list.

Example: OPENOFFICE, MICROSOFT WORD, MICROSOFT EXCEL

Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting Global settings in the heading's panel.

The lower part is then activated.
Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the **OK** button.

If the modification should not be taken into account, click on the **Restore** button.

**Delete a heading**

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
**USE**

cf. *Use of Headings*

**Display**

These heading's are displayed like all the others: cf. *visual information*

**Enter a value to a resource**

In the resource properties window: **Right click on a resource** > **Modify**

or in the event properties window: **Right click on an event** > **Modify**

Select the chosen value.

**Research and filter criteria**

They allow to use *Autofiltering*.

**Create/modify/delete a value**

- Create a new value into the list: when creating a new value, this one is directly available in the corresponding drop-down menu. It is the same behaviour for a dimension or form heading.
- Modify an existing value: Modifying a value impacts all the resources that have this value. The value is replaced. It is the same behaviour for a dimension or form heading.
- Delete an existing value: Deleting a value impacts all the resources that have this value. The value is definitely deleted. It is the same behaviour for a dimension or form heading.

**Use by other features**

- **Sort**
- Identification heading
- Events Report
- Export Resources
- Export Events
- Filters
- Multiple Choice Heading

Heading, list, single, choice
Multiple Choice Heading

DEFINITION

This is a type of heading for a dimension or a form.

A Multiple choice Heading allows to define some values to a resource or an event.

SETTINGS

Create a heading

To create a Heading, go to Global Settings panel:

- Right click on the chosen dimension's name > Create heading
- or Right click on the chosen form's name > Create heading
The lower part of **Global Settings** is then activated:

![Heading](image)

Specify the characteristics of the heading, then confirm by clicking on **OK**.

These settings are also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Multiple Choice List Heading** are the following:

**Name**

This is the heading's name.

**Description**

This is the heading's optional description.

**Type**

The type is **Multiple Choice List**. It can not be modified.

**Default Value**

A default value can be used for the creation of a new resource or event.
List of Value

The possible values are the following:

![Edit Values Window](image)

**Add a value in the list**

To add a value in the list, simply click on **Enter a value**.

**Modify an element of the list**

To change the value of a list, simply click on the value and modify the existing value.

**Delete an element of the list**

To delete an element, simply click on the value and select the button **Delete**.

**Sort the elements of the list**

- To automatically sort all values in the list, simply click on the **Sort** button.
• It is possible to make an manual sort by using the blue arrows.

Paste elements from clipboard

After making a **Copy** in an external application, it is possible to paste the entire list by clicking on the **Paste** button. The values are added like new elements in the list.

Example: OPENOFFICE, MICROSOFT WORD, MICROSOFT EXCEL

Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

**It is a powerful act of setting which should not be made without consideration.**
(cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The lower part is then activated.

Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

cf. Modify a heading

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.
It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

Display

The visual representation of a horizontal multiple-choice list is done by the | character as below:

```
| Heading 1 |
| Value 1   |
| Value 2   |
```

cf. visual information

Enter values to a resource

In the resource properties window: **Right click on a resource > Modify**

or in the event properties window: **Right click on an event > Modify > Form tab**

Select the chosen values:

To make a multiple selection, it is necessary to click on the **Ctrl** button on the clipboard.

Use by other features

- Sort
- Identification heading
- Events Report
- Export Resources
- Export Events
- Filters
- Single Choice List Heading

Heading, list
Attachment heading

DEFINITION

This is a type of heading for dimension or form.

Attachment heading allows to attach a file or Web page to a resource or an event.

This can be:

- a link,
- an uploaded file on VISUAL PLANNING server,
- an uploaded file on another Web server using WebDAV protocol.

SETTING

Create a heading

To create a Heading, you must go to Global Settings panel:

- **Right click on the dimension's name** > Create heading > Attachment
- or **Right click on the form's name** > Create heading > Attachment
- or **Right click on the name's heading** > Create heading > Attachment
The lower part of **Global Settings** is then activated

Specify the characteristics of the heading, then confirm by clicking **OK**.
This setting is also accessible by another entry point (c.f Global Settings).

Characteristics of an Attachment heading are the following:

**Name**

This is the heading's name.

**Description**

This is the heading's optional description.

**Type**

The type is **Attachment**.

**Maximum files number**

Define maximum files number to be attached, between 1 and 10 files.

**Type of attachment**

- **Local**: Define the local path of any file or any web page. (eg. links only)
- **Upload files**: Upload any files from VISUAL PLANNING's server.
- **WebDAV**: Use WebDAV protocol.

**Attributes that defines the path**

If **Upload files** is selected, you must define the directory structure with several headings or attributes.

**Suffix**

If **Upload files** is selected, the path structure creates a folder at the end of the directory tree.
Prefix

If **Upload files** is selected, the path structure creates a folder at the beginning of the directory tree.

URI WebDAV

If **WebDAV** is selected, you must define a root WebDAV URI.

```webdav://username:password@monserveur.com```

Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

**It is a powerful act of setting which should not be made without consideration.**
(c.f. precautions to take when modifying the settings)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The following lower part is then activated:

Then it is necessary to modify the characteristics (c.f Create a heading), then Validate by clicking on the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

c.f. Modify a heading

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

**It is a powerful act of setting which should not be made without consideration.**
(c.f. precautions to take when modifying the settings)

Deleting a heading is irreversible.

c.f Delete a heading
USE

c.f. Use of heading

Visualization

These heading's are visualized as all the others: c.f heading's visualization

Attach a document or page

In the properties window of resources: Right click on a resource > Modify or in the properties window of events: Right click on an event> Modify > Tab Form

Attachment heading are visualized like that:

The [Folder Browse Icon] allows to browse folders to select a file to attach:

Drag and drop any documents directly on a event or a resource in order to attach them in the heading.
Drag and drop any E-mail from Microsoft Outlook directly on a resource in order to attach it in the heading.

In the case of a web page, it is possible to write directly into the text box:

![Attachment heading:](www.visual-planning.com)

### Launch an attachment

There are two conditions:

- The document is available from the file manager of the computer that runs it. For a web page, it is necessary to have an Internet connection
- The client station has an application that is able to read the file. (For example: a spreadsheet for the *.CSV file)

The blue arrow ![blue arrow](image) allows to launch the file or the Web page attached.

An other access point to launch attachments is in table mode:

- schedule view,
- resources view,
- events view.

In this case, if several files are attached, a window comes up to select the file to be launched.

### Remove an attachment

To remove an attached file it's necessary to highlight the file name and press Delete on the keyboard.

The following message appears:

![Question dialog](example.png)

**Use by other features**

- Sort
- Email
From:
https://www.visual-planning.com/doc/

Permanent link:
https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_de_type.attachement

Last update: 2014/08/22 09:47
Barcode heading

DEFINITION

This is a type of heading for a dimension or a form.

The barcode standards that work in VISUAL PLANNING are EAN 8, EAN 13 and Code 39.

SETTINGS

Create a heading

To create a Heading, go to Global Settings panel:

- Right click on the chosen dimension's name > Create heading
- or Right click on the chosen form's name > Create heading
The lower part of **Global Settings** is then activated:

![Barcode Heading](image)

Specify the characteristics of the heading, then confirm by clicking on **OK**.

These settings are also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Barcode** heading are the following:

**Name**

This is the heading's name.

**Description**

This is the heading's optional description.

**Type**

The type is **Barcode**. It can not be modified.

**Barcode type**

The different **Barcode** are :

- EAN 8 code: c.f [EAN_8](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_de_type_code_barre)
- Code EAN 13 code : c.f [EAN_13](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_de_type_code_barre)
Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The lower part is then activated.

Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the **OK** button.

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

cf. Heading use

Display

These heading's are displayed like all the others: cf. visual information

In VISUAL PLANNING, it is not possible to visualize the result of a barcode heading as a design outside the resources or events windows properties. The display is usually in the form of text only.

Enter a value

Depending on the type of barcode, entering a value is possibly subject to validation.

The Code EAN 8 and EAN 13 are verified while Code 39 is not.

EAN 8 Code

Correct entry

Incorrect Entry
EAN 13 Code

Correct entry

Incorrect Entry

Code 39

Use by other features

- Sort
- Events report
- Export Resources
- Export Events
- Filters

heading, barcode
Geolocation heading

DEFINITION

This is a heading type of a dimension.

This type of heading allows locating a resource. The GeoLocation can be completed in two ways:

- automatic location
- manually location (requesting GPS data)

SETTINGS

Create a heading

In Global Settings

- Right click on the dimension's name > Create heading > Choose heading type
The panel on the bottom side of the Global Settings is then activated:

The next step is the definition of the different features of the heading, then click **OK**.

The settings are also accessible within the block (cf. **Global Settings**).
A **GeoLocation** heading has the following characteristics:

**Name**

It is the name of the heading.

**Description**

It is an optional description of the heading.

**Heading type**

The type is **GeoLocation**.

**Automatic location**

When checked, it is necessary to previously create headings, which will define the location of the resource. These headings will be selected in the following part **Location headings**.

When not checked, it is necessary to directly fulfill the resource GPS data in the **GeoLocation** heading.

**Location headings**

The **Location headings** allow selecting previously created headings, for defining the position of the **GeoLocation**.

The heading types that can be used are:

- Text
- Multi-line text
- Counter
- Barcode

Example of headings which could be used (all are in “text” format):

- Number
- Street number/name
- Zip code
- Town/City
- Country
In order to select the headings, click the button 📁, in front of the **Location headings**.

**The following window appears:**

![Image of window for selecting location headings]

You then need to select the **location headings**, from the **Available entities** and transfer them to the right, to **Selected entities**.

**Modify a heading**

The modification of a Heading involves an important change in the planner's architecture.

**It is a powerful act of setting which should not be made without consideration.**  
(cf. **precautions to take when modifying the settings**)

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The lower part is then activated.

Then it is necessary to modify the characteristics (cf. **Create a heading**), then Validate by clicking on the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

For the **GeoLocation** heading, it is possible to modify the **location headings**, without being alone connected in the planner.

cf. **Modify a heading**
Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

cf. Use of Headings

Visualization

These headings are displayed like all the others: cf. heading's visualization.

Enter values to a resource

In the resource properties window: **Right click on a resource > Modify**

A **Geolocation** heading appears like that:

<table>
<thead>
<tr>
<th>Street name/number</th>
<th>2415 3rd St</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zip code</td>
<td>CA 94107</td>
</tr>
<tr>
<td>Town/City</td>
<td>San Francisco</td>
</tr>
<tr>
<td>Country</td>
<td>USA</td>
</tr>
<tr>
<td>GeoLocation Heading</td>
<td>37.759647,-122.388316</td>
</tr>
</tbody>
</table>

Fill in the following characteristics depending on the chosen settings:

- If the location of the resource is automatic, the **Location headings** must be fulfilled.
- If the location of the resource is manual the **GeoLocation heading** must be directly fulfilled.

View Location

To display the position of the resource, click the button ![location icon] to load the position in MapQuest.

The following window appears:
Research criteria and filters

These headings can be sorted like the others: cf. Research criteria and filters

Assign/modify/delete a location value in heading

- Create a new value into the list: when creating a new value, this one is directly available in the corresponding drop-down menu.

To create Headings used for GeoLocation, it's mandatory to be the only user connected on the planner.

- Modify an existing value: Modifying a value impacts all the resources that have this value. The value is replaced.

- Delete an existing value: Deleting a value impacts all the resources that have this value. The value is definitely deleted.
Use by other features

- GeoLocation
- Filter
- Events Report
- Distance heading

heading, Geolocation, location, Distance, trip, position, travel, way
Distance heading

DEFINITION

This is a heading type of a form.

The “distance” heading possesses a display format.

SETTIN GS

Create heading

In Global Settings

- Right click on the form's name > Create heading > Choose heading type
Before creating the heading, it is necessarily to create the form.

The panel on the bottom side of the **Global Settings** is then activated:

![Heading panel](image)

The next step is the definition of the different features of the heading, then click **OK**.

The settings are also accessible within the block (c.f. **Global Settings**).

A **Distance** heading has the following characteristics:

**Name**

It is the name of the heading.

**Description**

It is an optional description of the heading.

**Start location**

This is the GeoLocation type heading which will represent the start location for calculating the distance.

**Arrival location**

This is the GeoLocation type heading which will represent the arrival location for calculating the distance.
Unit

This is the distance unit: Kilometer or Mile

Display format
This is the format for displaying the heading. Several formats are available:

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>12.00</td>
</tr>
<tr>
<td>0</td>
<td>12</td>
</tr>
</tbody>
</table>

Modify a Heading

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting it in the Global settings panel.

The lower part of the panel is then activated.

Then it is necessary to modify the characteristics (c.f. Create heading), then Validate by clicking on the OK button.

If the modification should not be taken into account, you must click on the Restore button.

(c.f. Modify a Heading)

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

(c.f. Delete a heading)

USE
cf. Use of Headings

Display

These headings are displayed like all the others: cf. heading's visualization.

Event creation

A distance heading does not need any particular use.

When an event is created, the distance heading (within a form) will automatically receive a value, function of its settings.

The user can only visualize the heading's value in the event's editor.

Use by other features

- Identification headings
- Events report
- GeoLocation
- Filter
- Operation Heading

Heading, type, GeoLocation, Distance, Location, position, journey
Signature Heading

DEFINITION

This is a heading's type for a dimension or a form.

Signature type allows to convert a manual signature in a picture format via VPPORTAL.

This type of heading is only available if the VPPORTAL is activated.

Create a heading

To create a Heading, go to Global Settings panel:

- Right click on the chosen dimension's name> Create heading
- or Right click on the chosen form's name> Create heading
The lower part of **Global Settings** is then activated:

![Heading](image)

Specify the characteristics of the heading, then confirm by clicking on **OK**.

This setting is also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Signature** heading are the following:

**Name**

This is the heading's name.

**Description**

This is the heading's optional description.

**Type**

The type is by default **Signature**. It can not be modified.

**Modify a heading**

The modification of a Heading involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*
The modification of a heading is done by selecting **Global settings** in the heading's panel.

The lower part is then activated.

Then, modify the characteristics (cf. Create a heading) and validate by clicking on the **OK** button.

If the modification should not be taken into account, you must click on the **Restore** button.

---

**Delete a heading**

The deletion of a Heading involves an important change in the planner's architecture.

*It is a powerful act of setting which should not be made without consideration.*

(cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

(cf. Delete a heading)
USE

cf. Heading use

Display

These heading's are displayed like all the others: cf. heading's visualization

As the content is an image, the representation is different from the other headings.

![Image of General section]

Enter a value

A value in a **Signature** resource or event can be filled only from a portable connexion through **VPPORTAL**.

Example of use: This field type allows a client to sign the report of the technician with a touch pad.

Use by other functions

- Filter

The information of the heading is an image. It is not posible to change it without a connection through **VPPORTAL**.

The use by other functions is important to know if the heading is filled or not.

**heading, type, signature**
From:
https://www.visual-planning.com/doc/ - VISUAL PLANNING 5.3 DOCUMENTATION

Permanent link:
https://www.visual-planning.com/doc/en/3-definition_de_la_structure/rubrique_de_type_signature

Last update: 2013/08/27 10:45
Password Heading

DEFINITION

This is a type of heading for dimension.

The Password heading allows the management of the passwords used by the users connected to the planning with VPPORTAL module. This management is done in a dimension of the planning.

Users management via a dimension makes easier the administration of VPPORTAL.

This type of heading is only available if VPPORTAL is activated.

Create a heading

To create a Password heading, go to Global Settings panel > Right click on the chosen dimension's name > Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

These settings are also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Password** heading are the following:

**Name**

This is the heading's name.
Description

This is the heading's optional description.

Type

The type is Password. It cannot be modified.

Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

The modification of a heading is done by selecting Global settings in the heading's panel.

The following lower part is then activated:

Then it is necessary to modify the characteristics (cf. Create a heading), then Validate by clicking on the OK button.

If the modification should not be taken into account, you must click on the Restore button.

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.
(cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

cf. Heading use

Display

These heading's are displayed like all the others: cf. heading's visualization

The content of the heading is hidden due to confidential reasons.

<table>
<thead>
<tr>
<th>Dimension 1 - (All) - (All)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
</tbody>
</table>

Enter a value

In resources properties windows, you can modify the value by a Right click on the resource > Modify.

During the entry of the value, the Password heading is like:

Once the modification of the resource is done, the visualization of the Password heading is like:

Use by other functions

- Filter
The information of the heading is coded. It is not possible to show, filter or decode it.

The use by other functions is important to know if the heading is filled or not.

**Heading, type, password**
Forum

INTRODUCTION

This document is the reference manual with a description about the activation and functionalities of the Forum for VISUAL PLANNING.

Reading some chapters of this manual assumes you have a good knowledge on VISUAL PLANNING. If necessary, refer to Use chapter.

DEFINITION

A Forum is a message board where users can hold conversations in the form of posted messages.

In VISUAL PLANNING, a forum is subjected on a resource.

Unlike Chatrooms, Forum archives messages of each user and offers an asynchronous communication.

PREREQUISITES

Technical prerequisites

The Forum option has been developed and validated for VISUAL PLANNING ESSENTIAL and VISUAL PLANNING ENTERPRISE, version 5.2.

Functional prerequisites

A Forum requires the creation of at least one dimension.

SETTINGS
Users rights

The visibility of all or part of forum for a user or a group can be managed in the Management of the permissions of VISUAL PLANNING.

It's is managed from editing rights of the dimension

- A Forum can be accessed by authorized users or groups.
- A Forum cannot be accessed, nor seen by users or groups that do not have a permission.

Activate a forum

To activate a forum, select the right dimension

In the following window, select “Activate a Forum” then click on “Validate”

Once a Forum is activated in a dimension, each resource of the dimension has an activated forum.
Inactivate a forum

To inactivate a forum, deselect the box corresponding to “Activate a Forum” in the dimension settings.

Use

Display

When the user is connected to the planner, if a forum is activated and if the user has the visibility rights on the forum, it can be launched:

- by double-clicking on any resource in a resource view and then clicking on the Forum tab.
- by right-clicking in a resource view and selecting Forum

The Forum will appear.
An opened Forum window avoids the browsing on the planner.

**Write a text message**

It is possible to write a text message in a forum. To do so, write a text in the writing window and send it by clicking on **Add** button.
Delete a text message

A text message in a forum can only be deleted when the user is connected. To delete a message, select the message itself and click on Delete.

- Deleting a message cannot be undone;
- An administrator is able to delete any or all messages in a Forum.
Icon

DEFINITION

Each icon is an image which size is 16 * 16 pixels. The color palette can extends over 16 million possible colors.

VISUAL PLANNING supports the possible pixel transparency.

Icons are linked to resources.

Thus, each resource can have an icon.

They are displayed in views and duration bar representing events.

SETTING

A resource can have an icon or not depending on the setting of its belonging dimension.

When setting up each Dimension, define the type of icon used by it.

The choices are:

- **None**: in this case, no resources of the dimension has an icon.
- **Icon**: in this case, the resources of the dimension will all have an icon that can be selected from the icon album. This icon may be different for each resource.
- **Heading**: in this case, resources will all have an icon automatically generated with part of content of a heading.

cf. Setting up a dimension

Icon album

Icons are configured in Icon album. It permits to:

- Create, modify and delete icons,
- Identify icons into defined categories.

For each dimension, you can define its resources using the album icons.

Thus, go to General Settings > Dimension > icon
Then, choose **Icon**, in the drop-down list.

The icon album opens to allow the selection of a default icon.

![Select icon window](https://www.visual-planning.com/doc/en/3-definition_de_la_structure/icone)

**cf. Icon Album**

**Icon according to a heading**

It is possible to use an existing heading to create an icon.

For this, go to **General Settings > Dimension > icon**

Then, choose **Heading**, in the drop-down list.

The following window appears:
Then, define the characteristics of this icon, and click on **OK**.

These characteristics are:

**Background color**

Choose the background color of the icon.

Keeping empty makes the background color transparent.

**Font color**

Choose the font color of the icon.

**Heading**

Choose the heading that is used to create the icon.

Choosing a **Resource Heading** assign the icon of the “dependent” resource

**Number of characters**

This is the number of characters to create the icon.
This number may be: 1, 2, 4 or 6.

<table>
<thead>
<tr>
<th>Number of characters</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>R Resource 1</td>
</tr>
<tr>
<td>2</td>
<td>Re Resource 1</td>
</tr>
<tr>
<td>4</td>
<td>RE Resource 1</td>
</tr>
<tr>
<td>6</td>
<td>RES Resource 1</td>
</tr>
</tbody>
</table>

<pagebreak>

**USE**

**Modify the icon of a resource**

If the dimension allows to have an icon (c.f. *definition of the icon when setting up a dimension*), it is then possible to choose an icon for each resource.

- **Right lick on a resource selection > Modify > Setting**

  c.f. *Modify a resource*

**Modify a resource icon by drag'n'drop**

It is possible to add an icon to a resource or modify an existing one. *drag'n'drop.*
This feature is only available in a resource view.

**Visualize the resource icon**

It is available in: schedule view and resource view.

**Visualize the event icon**

It is available in schedule view, diary view and events view.

The management of this visualization is done through duration bar.

Icon, event, resource

From: [https://www.visual-planning.com/doc/ - VISUAL PLANNING 5.3 DOCUMENTATION](https://www.visual-planning.com/doc/ - VISUAL PLANNING 5.3 DOCUMENTATION)


Last update: 2013/08/19 09:23
Icon Album

DEFINITION

The Icon Album is the set of icons available for resources and events. This album is organized by category.

SETTINGS

The album of icons is set up with the Menu bar at the top of the main window.

By clicking on the panel Icon Album (cf. Visualizing album), the block Icon Album is activated in the menu Edition:

Add a category

To add a new Icons category in the album, just Left-Click on the album > Menu Edition > Album > Add

The following window appears:
Then enter:

- a **Name**
- a **Description**

The new category is immediately seen in the Album:
Delete a category

To delete a category, simply left-click on the album, then Edit Menu Edition > Album > Delete.

Import one or more icons

To import icons, left-click on the album, then Edition Menu > Album > Import.

To import, the file formats that are accepted are: *.zip, *.PNG, *.GIF, *.BMP, *.JPG

Two cases exist:

Import of one icon

The file must be in the following format: *.PNG, *.GIF, *.BMP ou *.JPG
The import create the icon in the first category (**actions** by default).

**Import of several icons**

The file must be in the following format: *.ZIP and must contain pictures in the formats *.PNG, *.GIF, *.BMP ou *.JPG

The import create a new category named like the file *.ZIP which contains the set of icons.

**Export icons**

Icons of a category of the album can be exported as *.PNG.

This export takes place as follows:

**Click on Export> Select category**

A window is opened, where you must select the directory where you want to export the icons.

**Create a new icon**

- **Left click on the icon**, then **Menu Edition > Album > Add > Select a category**

The window of icons creation appears:
The drawing tools available are:

- Pencil
- Eraser
- Fill Action
- Line
- Rectangle
- Text Action
- Clear Action
- Color
- Preview

**Duplicate an icon**

- Left click on an icon, then Menu Edition > Général > Duplicate

A new icon is then created in the same album.
Modify an icon

- **Left click on an icon**, then *Menu Edition > Général > Modify*

  or

- **Double-click on icon**

  The edition window opens:

  ![Edition window](image)

  Then, the icon can be modified with the same tools than those of the *creation of a new icon*.

Change the icon category

To change the category of an icon, just drag and drop the icon from another category.
USE

Visualize the album

Menu settings > Windows > Icon album

The dedicated panel appears:
Assign an icon to a resource

Two ways are available:

- Either by Modify the icon by a drag&drop (only for the ressources view).
- Either while Modify a resource

Album, icon, resource
Multi-line Text Heading

DEFINITION

This is a type of heading in a dimension or a form.

The Multi-line Text type allows to write in a field all the text that is expected.

It can take a Default value.

SETTING

Create a heading

To create a Heading, you must go to Global Settings panel:

- Right click on the chosen dimension's name > Create heading
- or Right click on the chosen form's name > Create heading
- or Right click on the chosen name's heading > Create heading
The lower part of **Global Settings** is then activated:

Specify the characteristics of the heading, then confirm by clicking on **OK**.

This setting is also accessible by another entry point (c.f **Global Settings**).

Characteristics of a **Multi-line Text** heading are the following:
Name

This is the heading's name.

Description

This is the heading's optional description.

Type

The **Multi-line Text** type is chosen.

Default Value

A default value can be used for the creation of a new resource or event.

It is possible to set this value with the global variables of the user:

- $USERNAME
- $GROUPNAME
- $USEREMAIL
- $USERFULLNAME

Modify a heading

The modification of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration.  
(cf. [precautions to take when modifying the settings](https://www.visual-planning.com/doc/))

The modification of a heading is done by selecting **Global settings** in the heading's panel.

The lower part of the window is activated.

Then, modify the characteristics (cf. [Create a heading](https://www.visual-planning.com/doc/)), and validate by clicking on the **OK** button.

If the modification should not be taken into account, click on the **Restore** button.
cf. Modify a heading

Delete a heading

The deletion of a Heading involves an important change in the planner's architecture.

It is a powerful act of setting which should not be made without consideration. (cf. precautions to take when modifying the settings)

Deleting a heading is irreversible.

cf. Delete a heading
USE

cf. Use of heading

Display

These headings can be displayed like the other headings: cf. visual information

Use by other functions

- Sort
- Identification heading
- Events reports
- Export Resources
- Export Events
- Filters

Heading, multi-line, text